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1 Introduction to 
release notes
Release 
notes

Maya 6.5 release notes

The Maya 6.5 release notes contain all of Maya’s known limitations and 
workarounds and is organized into chapters according to Maya’s 
functionality. 

To find out which limitations were fixed for this release, see Chapter 2, 
“What’s fixed in Maya 6.5.”

ATTENTION Users of the IRIX Operating System

Over the past few years, there has been a significant decrease in the 
number of Maya customers relying on the IRIX operating system for 
running Maya interactively. As a result, Maya 6.5 will be the last upgrade 
release for IRIX. Going forward, Alias will concentrate its development of 
Maya on the remaining platforms, namely Windows, Mac OS X and 
Linux. Alias will however continue to offer support for IRIX as a license-
serving platform.

For further details, please contact your Alias authorized representative or 
go to www.alias.com/irixnotice. 
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2 What’s fixed in 
Maya 6.5
Release 
notes

What is what’s fixed?

In Maya 6.5, we've corrected some problems in the Maya software that 
have been reported by our customers. For new features and 
improvements, see “What’s new and improved in Maya 6.5” in the What’s 
New in Maya guide.

The following sections list the software limitations that were fixed for 
Maya 6.5.

What’s fixed in general

The following lists general limitations that were fixed for Maya 6.5.

Web browser preference directory

On Windows, the Maya 6.0 Web browser incorrectly created its 
preference directory in C:\Windows\MayaWebBrowser\. This has been 
fixed; the directory is now created correctly in C:\Documents and 
Settings\<username>\Application Data\MayaWebBrowser. You 
can delete the incorrect directory. Because of this fix, you must re-set 
any non-default Web browser preferences if you’re upgrading from 
Maya 6.0 to Maya 6.5.  

Channel Box colors

Channel Box colors on all platforms are now the same. There is no 
differentiation per platform. For a list of colors, see “Channel Box” in 
the Basics guide.

Marking menus on multiple-monitors

On Windows, marking menus now display properly on a multiple-
monitor setup. They now display on the monitor that the cursor is 
located on.  This includes right-mouse button popup menus and 
Tooltips. Previously, marking menus only displayed correctly on a 
single monitor. 

Unload References removed

File > Save Scene As >  no longer has an Unload References option. 
In previous versions of Maya, scenes containing file references would 
be stored with all file references unloaded, when this option was 
selected. The selective preload of scenes containing file references, 
when saved in this manner, was improved as a result. Recent 
improvements to file referencing’s architecture and the selective 
preload feature make this option obsolete.
Maya 6.5 Release Notes
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2 | What’s fixed in Maya 6.5
Release notes > What’s fixed in animation
Remove Reference works on multiple file references

In the Reference Editor, you can now select and remove multiple file 
references using the Reference > Remove Reference command.

Component editor fixes

The following fixes have been made to the Component Editor in Maya 6.5:

• Hide Zero Columns in the Component Editor no longer hides boolen-
valued attributes that have a value of false. 

• Entering a value for multiple cells in the Component Editor was not 
working on Windows, IRIX, and Linux with disparate workflows. The 
common workflow now is to click on the column header (to select all 
cells in the column) and then Shift+click in any selected cell in this 
column to move the input field to that cell. 

• The Component Editor limit of 1024 rows to display has been 
removed. 

What’s fixed in animation

The following lists animation limitations that were fixed for Maya 6.5.

Bake redirected animation

You can now bake redirected animation. For more information on 
redirecting animation, see “Redirecting character animation” in the 
Character Setup and Deformers guide.

Scrubbing sound on Windows

Maya no longer crashes while scrubbing sound on Windows 
machines. 

Pasting keys

When pasting keys in the Timeslider, the pasted keys no longer 
replace all other keys in the selected region. 

audioWave Bonus Tools plug-in

The audioWave plug-in in the Maya Bonus Tools now outputs correct 
values for the amplitude of audio signals. 

Set Driven Key channels in the Graph Editor

In Maya 4.5, when selecting a joint that has multiple Set Driven Key 
channels, the channels would show up with the correct name in the 
Graph Editor. In Maya 5.0, 6.0, and 6.0.1, these custom channels did 
not show up. This has been fixed. 
Maya 6.5 Release Notes
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2 | What’s fixed in Maya 6.5

Release notes > What’s fixed in character setup and deformers
Playblasting to .avi format

When playblasting to .avi format, playblast files previously created 
during the same Maya session could be deleted. This would typically 
occur if one of the playblast attempts failed. This has been fixed. 

What’s fixed in character setup and deformers

The following lists character setup limitations that were fixed for Maya 
6.5.

User set vertex normals on skinned meshes

User set vertex normals now deform with skinned meshes when you 
add the normals to the meshes before skinning and/or you use Skin > 
Edit Smooth Skin > Delete Non-Skin History.

Skin clusters crash Maya

Maya no longer crashes while operating on skin clusters (most often 
in the Component Editor).

 Multiple bind poses

Multiple bind poses can no longer exist for a joint. 

Painting smooth skin weights

When painting smooth skin weights, undo was unreliable. It now 
works reliably. 

Paint Skin Weights now respects the Max Influences Smooth Bind 
option. 

Delete Non-Skin History

Delete Non-Skin History would fail to remove influences (even 
though the extra influences had weights of zero). All influences are 
now properly removed. 

Delete Non-Skin History would sometimes delete all history. This no 
longer occurs. 

What’s fixed in modeling

The following list modeling limitations that were fixed for Maya 6.5.

UV Texture Editor: pivot

It is now possible to immediately edit the pivot location for a UV 
selection without first having to click-drag directly on the pivot point. 
Previously, when UVs were selected for rotation and you entered the 
pivot edit mode, it was necessary to click-drag directly on the pivot 
point before being able to move the pivot point. 
Maya 6.5 Release Notes
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2 | What’s fixed in Maya 6.5
Release notes > What’s fixed in rendering
UVs in binary Maya files

UVs on meshes with multiple UV sets are no longer corrupted when 
saving binary Maya files as ASCII. 

Polygons > Mirror Geometry

Mirror Geometry now works on multiple objects, rather than just on 
the last selected object. 

Polygons > Smooth

• Smooth no longer generates NAN values for UVs when exporting 
to mental ray. 

• When a polygonal object was skinned and then smoothed using 
Polygon > Smooth, the animation on the object's skeleton 
modified its UVs at every frame. In Maya 6.5, the polygonal 
object’s UVs are modified only when the Smooth UVs option is 
on. 

Edit Polygons > Merge Vertices

Merge Vertices no longer destroys user-defined normals. 

What’s fixed in rendering

The following lists rendering limitations that were fixed for Maya 6.5. 

Perspective view won’t render unless selected

The perspective view is now rendered automatically (without being 
selected first) when no particular view is specified for rendering. 

Command line rendering

• -s or -e flags and animation

When the -s or -e flags are set, animation is now automatically 
turned on.

• -rd flag

Issues with the -rd flag (including aborted renders) have been 
resolved.

FCheck -c

The FCheck -c command now returns 0 for success, and a non-zero 
value otherwise. This is useful in identifying corrupted images.

Normal mapping and double sided faces

Normal maps generated for double sided faces now correctly include 
the back face intersection.
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2 | What’s fixed in Maya 6.5

Release notes > What’s fixed in rendering
Attaching a PSD file with uniform alpha to displacement

When attaching a PSD file with uniform alpha to Displacement, you 
now see the correct effect.

mental ray for Maya

Baking

• Baking with Final Gather

A number of issues with baking and final gathering have been 
resolved (including  stepped shading, incorrect textures, and lightmap 
quality) with the introduction of the Final Gather Quality attribute. 
For more information, see “Texture bake-set Final Gather Quality” in the 
What’s New in Maya guide.

• Incoming Illumination

Issues with Incoming Illumination have been resolved. For more 
information, see “Improved Baking” in the What’s New in Maya guide.

• Inaccurate lightmaps when baking to texture

Issues with inaccurate lightmaps have been resolved by introducing 
the new Occlusion color mode. For more information, see “Improved 
Baking” in the What’s New in Maya guide.

• Vertex baking with color only

Previously, when baking vertices with color only, Maya added an 
alpha value of -1 if the color-per-vertex node did not exist in the mesh, 
causing objects to become transparent.

In this case, Maya now adds an alpha value of 1 (an opaque value).

Motion blur delay with Fur rendered in mental ray for Maya

Previously, some motion blurred fur rendered in mental ray for Maya 
was rendered slower than the object, resulting in the fur being 
displaced from the object. Motion blurred fur renders correctly in 
Maya 6.5.

Render Active mode and mental ray for Maya

The Render Active mode for mental ray for Maya now behaves the 
same as other Maya renders. Specifically, this means that when you 
select a node in the hierarchy, mental ray for Maya is now able to 
render any objects under that node in the Render Active mode. For 
more information, see “Render Global Settings: Common tab” in the 
Rendering guide.

Bump mapping multiple UV sets

Bump mapping multiple UV sets is now supported by mental ray for 
Maya.
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2 | What’s fixed in Maya 6.5
Release notes > What’s fixed in rendering
Receive Shadows and Double-Sided/Opposite Attributes on 
geometry

These geometric attributes are now supported in mental ray for Maya.

Glow framebuffer with post effects

When post effects are turned off, the glow framebuffer is no longer 
allocated.

Image planes

The placement of the image plane now matches between the Maya 
Software renderer and mental ray.

Preview Final Gather Tiles and Global Illumination presets

In the mental ray Render Global Settings, when you turn on the 
Preview Final Gather Tiles option, Global Illumination is not turned 
on automatically.

Previously when the Preview Final Gather Tiles option was turned on, 
Global Illumination was automatically turned on as well.

Software rendering

IBL (image-based lighting) causing rendering failures

To prevent IBL from causing rendering failures, the Maya Software 
renderer now ignores the IBL node, and creates a default light if no 
other light exists.

Hardware rendering

Viewing mipmap filtering in the scene view without Hi Quality 
Render

You can now see the effects of mipmap filtering in the scene view 
without using Hi Quality rendering.

Normalized tangent vectors

The tangent vectors available through the hardware shader 
(MPxHwShaderNode) OpenMaya API are now passed as normalized 
vectors. These vectors were previously not normalized.

Rendering file textures with a dual monitor system

The Hardware Render Buffer now renders file textures on a dual 
monitor system.

2D texture placement parameters

The following 2D texture placement parameters now render correctly, 
and match the results of Maya's software renderer:
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2 | What’s fixed in Maya 6.5

Release notes > What’s fixed in the CGFx plug-in
• offsetUV

• rotateUV

• translateFrame

• staggerFrame

What’s fixed in the CGFx plug-in

The following lists CGFx plug-in limitations that were fixed for Maya 6.5.

• CGFx plug-in requires all files to be in the same directory

In Maya 6.5, CGFx plug-in files do not need to be in the same 
directory.

• Default texture nodes

When you create a CGFx shader, a file texture node is now 
automatically created and connected for each default texture specified 
in the shader.

• Unused nodes

When you change the effect used by a CGFx shader node, the plug-in 
now deletes the unused nodes (when it is the only node using that 
texture/placement node). Previously, the unused nodes were not 
deleted, resulting in extraneous file texture and placement nodes in 
the scene.

• Default CGFx effect

When you create a new CGFx shader and no effects file is available, 
the plug-in now renders a basic shaded geometry.

• Default CGFx texture

When you create a new CGFx shader and no texture is configured, the 
plug-in now renders a stand-in texture so that the effect is still visibile 
in the scene. Previously, the plug-in rendered black when textures 
were not configured.

What’s fixed in Artisan

The following lists Artisan limitations that were fixed for Maya 6.5.

Painting vertex colors

• When painting vertex colors on polygons that are backface culled, 
the culled part of the surface no longer receives paint. See “About 
Maya performance improvements” in the What’s New in Maya guide. 

• Painting vertex colors no longer uses a lot of memory. 
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Release notes > What’s fixed in 3D Paint
Paint Scripts Tool and subdivision surfaces

The Paint Scripts Tool (formerly Script Paint Tool) in the new Artisan 
architecture (as of Maya 6.0) can now be used on subdivision surfaces. 

What’s fixed in 3D Paint

The following list 3D Paint Tool limitations that were fixed for Maya 6.5.

You no longer need to leave the 3D Paint Tool before changing the 
texture name in the Attribute Editor. 

What’s fixed in Dynamics

The following lists Dynamics limitations that were fixed for Maya 6.5.

Die on Emission

When creating particle emitters, Die on Emission was not working 
properly in Maya 6.0/6.0.1. It is now working properly. 

Evaluation of dynamics

Evaluation of dynamics would sometimes produce different results 
when you first loaded a scene versus when you stepped forward and 
back through the simulation. 

What’s fixed in Fluid Effects

The following lists Fluid Effects limitations that were fixed for Maya 6.5.

setFluidAttr command

The setFluidAttr command now behaves as expected when the -
addValue flag is used. 

Wake Texture

Wake Texture now behaves as expected when the Boundary attribute 
is set. 

What’s fixed in Hair

The following lists Hair limitations that were fixed for Maya 6.5.

Hair constraints

On Linux, IRIX, and Mac OS X deleting a hair constraint may have 
resulted in a crash, but this has been fixed in Maya 6.5.  
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Release notes > What’s fixed in the API and Developer’s Tool Kit
Hair caching

Hair caching on hair systems now performs as expected after follicles 
have been deleted or passive follicles were used; however, the cache 
needs to be recreated. 

Painting Hair attributes

If you were painting hair attributes such as Surface Inset and 
Inclination that actually end up modifying transforms of hair objects, 
and you hit a passive follicle where there was no start curve, it would 
end up transforming the last selected object instead, so that an object 
totally unrelated to the hair system could end up with the transform 
intended for the hair. This has been fixed. 

Hair Smooth Curve

Previously, Smooth Curve worked by averaging CV positions, which 
often resulted in undesirable behavior. It now smoothes the curvature. 

What’s fixed in the API and Developer’s Tool 
Kit

The following lists API and Developer’s Tool Kit limitations that were 
fixed for Maya 6.5.

• MFnAttribute::create() now allows long and short names to be the 
same. Passing in the same long and short names into 
MFnAttribute::create() no longer causes an error. 

• MFnDependencyNode::addAttribute() no longer fails if 
MAttrClass type of the attribute added is kGlobalDynamicAttr. 

• The Maya plug-in wizard for .NET 2003 no longer uses the 
ABSOLUTE_PATH parameter.When adding a compound 
attribute to MFnNumericAttribute::create(), Maya now checks to 
see if the compound attribute has the same name as any of the 
current children of MFnNumericAttribute::create() . 
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3 Basic interface
Release 
notes

General UI limitations 

The following limitations and workarounds relate to general UI issues. For 
platform-specific UI issues, see:

• ”Maya for Windows limitations” on page 124

• ”Maya for Linux limitations” on page 124

• ”Maya for Mac OS X limitations” on page 128

Problems loading some very large files 

We made speed improvements to polygon drawing in Maya 6.5 that 
involve using a polygon draw cache. When loading certain very large 
files in Maya 6.5, the polygon draw cache of Maya may cause the 
memory usage of Maya to exceed the memory available to the 
application on your system, resulting in instability.

If you are using Windows XP, we suggest you increase the application 
memory limit of Maya; for instructions on how to do this, see xref.

As well, we have added a mechanism to disable the polygon draw 
cache so that you can more easily load very large files. There is a new 
environment variable called MAYA_DISABLE_POLYGON_DRAW_CACHE. Set 
it to 1 to disable the polygon draw cache.

If you disable the polygon draw cache, interactive draw performance 
will be slower. We recommend that you not leave this environment 
variable set to 1, but instead set it only for working on files that 
evidence this problem. 

Maya 6.0 and Windows XP SP 2

If you’re still running Maya 6.0, you may experience problems under 
Windows XP SP 2 where Maya may fail to start. This is a known issue 
with Windows; please see:

support.microsoft.com/
default.aspx?kbid=842242&product=windowsxpsp2

Alias DirectConnect does not auto-load

If you chose to copy preferences from a previous version of Maya the 
first time you run Maya 6.5, Alias DirectConnect (new in Maya 6.5) 
does not load automatically. To get the functionality of Alias 
DirectConnect, turn on DirectConnect in the Plug-in Manager. 
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Release notes > General UI limitations
Node names with digits

For comparison purposes, digits which are embedded in node names 
are evaluated as numbers as opposed to characters. Occasionally, if a 
node name contains a particularly long series of digits, this can result 
in a crash. 

Workaround

To prevent these crashes try to limit the size of embedded numbers.

Tear-off menus and Windows XP

Tear-off menus in Maya have display problems when using Windows 
XP Style UI schemes. 

Workaround

Select Start > Control Panel and double-click the Display icon. Select 
the Appearance tab and change UI scheme to Windows Classic.

Hotkeys disabled when using Attribute Editor in main window

If you have the Attribute Editor open in the main window, and you 
click it, type in a new value, and then press Enter, the keyboard focus 
stays in the Attribute Editor. This means your hotkeys will not work 
until you return focus to the modeling window. 

Workaround

To get the focus back into the modeling window without changing 
anything else, move the mouse over the window and click with the 
middle mouse button. 

Speeding up interactive performance on UNIX machines

On UNIX machines, you can speed up Maya’s interactive performance 
by closing or hiding the Attribute Editor when you are not using it. 
Motif (the software supporting the windowing system on IRIX) can be 
very slow to rebuild the widgets. 

Using the grid in perspective view

If you are working in non-default units, you may not see the grid in 
perspective view when you first open a file. The problem is that the 
grid is created at the wrong size. Zooming out will show it. 

Workaround

Select Display > Grid >  and click the Reset button. Then on the 
view panel select View > Default Home.

Tearing off menus with check boxes or radio buttons

If you tear off a menu that has check boxes or radio buttons and leave 
it open, the check marks and buttons may not update. 
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Release notes > General UI limitations
Workaround

Close the menu, then reopen it

Setting rotation and translation limits in the Channel Box

You cannot set rotation and translation limits in the Channel Box. 

Workaround

Use the Attribute Editor. To set the limits of many objects at once, use 
the All tab in the Attribute Spread Sheet (Window > General Editors > 
Attribute Spread Sheet).

Using torn off panels in panel layouts

Panel layouts cannot use panels that have been torn off. If you select a 
panel layout that includes a torn-off panel, Maya displays a warning 
that it cannot use the panel. Any available panel is used instead. For 
example, the built-in Persp/Outliner panel layout usually places the 
Outliner in the left pane and the Perspective view in the right pane. If 
you tear the Outliner off into its own window, a warning is issued 
and another panel is put in place of the Outliner.

Workaround

Once you close the tear-off panel, it can be used by panel layouts that 
include it.

Edit option menu for mode selection disabled for tools

Option windows for tools and actions include an Edit option menu at 
the top of the window that allows you to pick between tool and action 
modes. Currently, only actions can be switched to tool mode. 
Therefore, for tools (for example, Birail Surface Tool), the Edit option 
menu is disabled.

Non-sequential Enum values in the Channel Box

The Channel Box will sometimes incorrectly display an enumerated 
attribute's pull-down menu. Extra menu items can appear that 
represent the numbers in between non-sequential option values. 

Workaround

Specify sequential values for the options of any enumerated attributes 
that will appear in the Channel Box. For example: 
“solo=1:triplet=2:quintet=3”.

Setting linear units

If you open a file that is set to linear units that are different from your 
current Maya session, the next time you use Maya it will adopt the 
unit settings from that file. 
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Workaround

1. Create an empty scene with the units and other preferences set as 
required. Save it. Use this as your Default Scene.

2. To ensure that a particular unit be used every time Maya launches, 
you can create a userSetup.mel file in your personal scripts directory 
containing the following lines: 

global proc myLinearUnit(){ 
currentUnit -linear xxxxxx; 
} 
scriptJob -event NewSceneOpened myLinearUnit; 

where xxxxxx is one of: millimeter, centimeter, meter, inch, foot, or 
yard. The recommended default is centimeter.

Field callbacks must not delete the window that contains the 
field

If the callback for a field in a window issues a deleteUI command for 
the window it is in, then Maya will suffer a fatal error. For example: 

window w; columnLayout; textField -cc "deleteUI w"; 
showWindow w; 

Workaround

Use the evalDeferred command. So in the previous example, change 
the textField command to:

textField -cc "evalDeferred(\"deleteUI w\")";

Selection marquee or panel contents disappear

Returning to Maya after a screen saver has been activated can, with 
some old or low-end graphics cards, cause selection marquees or 
panel contents to disappear. 

Workaround

Press the space bar or use the Panels menu to change the current 
panel configuration. All panels should now be drawing normally. To 
return to your previous configuration, either press the space bar 
again, or select the appropriate entry from the Panels menu.

Selecting components with the Lasso Tool

The Lasso Tool, when the Selection Mode is set to Object, can 
sometimes fail to select objects or highlighted components. This will 
typically occur when the lasso approaches an item of higher Selection 
Priority. 

Workaround

If selecting components, set the Selection Mode to Component. 
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Release notes > Node limitations
Isolate Select not working for subdivision surface vertices or 
edges

Isolate Select does not work for subdivision surface vertices or edges. 

Workaround

Isolate subdivision surface faces instead. 

Running Maya maximized blocks auto-hide task bar in 
Windows 2000 

Under Windows 2000, if you run Maya with the title bar off (Maya 
option) and maximized with Auto hide on your Taskbar (Windows 
options), then you won't be able to get your Taskbar to come up. 

Workaround

Don't use the Auto hide feature of the Windows Taskbar. 

Node limitations

Node names with digits

For comparison purposes, digits which are embedded in node names 
are evaluated as numbers as opposed to characters. Occasionally, if a 
node name contains a particularly long series of digits, this can result 
in a crash. 

Workaround

To prevent these crashes try to limit the size of embedded numbers.
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4 Animation
Release 
notes

General animation limitations

The following limitations and workarounds apply to general animation 
features.

Ghosting subdivision surfaces crashes Maya 
(Linux and Mac OS X) 

Scenes that contain ghosted subdivision surfaces displayed in 
Wireframe mode crash Maya on Linux and Mac OS X. 

Workaround

Avoid ghosting subdivision surfaces, or ghost them when in Shaded 
display mode.

When you merge character sets, clips are copied, but not 
blends between clips

Workaround

Restore the blend manually after merging. 

Pair blend/quaternion animation curve combination can cause 
jump on creation 

If your rotation curves default to synchronized quaternion 
interpolation, setting a key on a constrained object can cause the 
orientation of the object in question to jump. 

Workaround

Re-enter the rotation values you wanted to key to, and re-key the 
rotation channels.

Can't import audio file in Windows

Can't import Apple's format of .wav files on a Windows machine. 

Workaround 

Convert the audio file to Windows compatible IMA ADPCM or PCM 
wave file.

Changing animation frame rate can cause Trax time warp and 
blend problem 

If you change the animation frame rate, Trax time warps and blend 
curves do not scale properly. 
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Release notes > General animation limitations
Workaround 

All time warp and blend curves must be scaled to compensate for the 
frame rate change. They are supposed to always be between 0 and 1, 
but when the frame rate changes they get scaled to fit the new 
framerate. You must scale the curves to fit between 0 and 1 in the time 
range.

Quaternion animation curves not correctly converted to Trax 
clip

Quaternion animation curves not correctly converted to Trax clip. 

Workaround

Quaternions in clips will only work properly if all three rotate 
channels are included in the character. This happens automatically if 
you use Maya's automatic character creation. However, if you create 
your character manually, you need to include all three rotate channels 
in the character if you want to use quaternions.

Synchronized quaternion curve

For synchronized quaternion curve, all three rotation channels on the 
object should exist at all times. Deleting one of the rotation channels 
will have unexpected results, such as changing the animation on the 
remaining channels. 

Workaround

Convert the curve to Euler angles before deleting the channel. Or set 
the rotation keys on the channel to a static value rather than deleting 
the channel.

Synchronized Quaternion rotation interpolation limitation

When keyframing rotations using the Synchronized Quaternion 
preference, rotations will be clamped between +/- 360 degrees. 

Unexpected behavior of animation if all three channels 
unsynchronized when modifying using the API

If you modify the keys of a synchronized animation curve (quaternion 
or synchronized Euler) using the API, you must keep all the 
keyframes synchronized on the three rotation channels. If all three 
rotation channels are not synchronized, your animation will behave 
unexpectedly and eventually crash. 

Audio files may not play in their entirety

Maya may not play the ending of the audio file based on the playback 
end time specified. 
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Release notes > Animation playblast limitations
Workaround

Extend the playback time beyond the audio file's end time or append 
extra dead space at the end of the audio file to compensate for the 
clipping.

Options in option windows (Edit > Keys menu) disabled for 
current characters

When a character is current, options in several option windows are 
disabled. The options are disabled because they operate on all the 
attributes of the current character. The option windows affected are 
the ones under the Edit > Keys menu item.

Workaround 

Set the current character to “None”.

Animation playblast limitations

(Windows) Playblast and Windows XP

Playblast may have problems on Windows XP. The playblast may 
hang or the animation may stop updating.

Workaround

Do the following:

1 Set Maya to run in Windows 2000 Compatibility mode. 

Right-click the Maya shortcut on the Desktop and select Properties 
from the pop-up menu. In the Maya Properties window, go to the 
Compatibility tab and turn on the Run this program in compatibility 
mode for checkbox and select Windows 2000 from the drop-down list. 
Then click OK. 

2 Set your Windows style to Classic.

Right-click the Deskop and select Properties from the pop-up menu. 
In the Display Properties window, go to the Appearance tab and 
select Windows Classic style from the Windows and buttons drop-
down list.

Playblast escape limitation

Before you can escape from playblast you have to wait for entire 
sound track to record.

Large imported audio files delay Playblast

The playback time of Playblast may be severely delayed in scenes 
with large imported .aiff audio files. For example, a 40MB .aiff file 
may cause a 20+ second delay between the initial command call and 
playback.
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Workaround

View and play all (as long as your audio clips do not overlap) your 
loaded audio files from the Trax Editor or use multiple short audio 
files rather than single large audio files.

Graph Editor limitations

The following limitations and workarounds relate to the Graph Editor.

Key tangents may become difficult to select

Key tangents may become difficult to select and/or manipulate when 
the Graph Editor’s displays a view with an extreme vertical-to-
horizontal ratio.

Workaround

Using the Graph Editor’s Curves > Spreadsheet menu item, enter a 
new value for the in- or out-tangent angle and invoke View >Frame 
Selected to resume interactively editing the tangent.

Copy/paste keys in Graph Editor

When cutting and pasting keys that include multiple animation curves 
to multiple attributes, pay particular attention to the order that you 
select them, as this will impact the order in which they are pasted. 

When cutting keys from multiple attributes in the Graph Editor or 
Dope Sheet, select the attributes from the Outliner-not the view area-
of the respective editor.

Trax limitations 

The following limitations and workarounds relate to Trax software.

Poses not displayed in Visor for character

Poses created for a character that has no attributes will not be 
displayed in the Visor. This occurs when you create a pose for a 
character that has no attributes, but does possess animated 
subcharacters.

Workaround

To get Visor to display the pose, set your current character to a 
subcharacter that contains attributes. The pose will be applied to all 
subcharacters that have attributes.

Clips in Trax that have the same start time or end time may 
jump

Clips in Trax that have the same start time or end time may jump 
when the clip starts/ends if there is a blend between them.
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Workaround

Do one of the following:

• Modify the hold on the final clip to control how long it plays.

• Use “Merge” on the blended clips to create a single clip. 

• Create a pose that corresponds to the start or end point of the 
blended clips, then drag and drop the pose into Trax immediately 
before or after the blended clips to force the character to keep the 
pose before or after.

Unable to create layered animation on top of a relative clip

Workaround

Merge the relative clip to replace the relative clip with an absolute 
clip, then create the layered animation on top of the absolute clip. 

Blends not working for certain clip configurations

When an absolute clip is followed by a relative clip and then blended 
into another absolute clip, the blend may behave incorrectly.

Workaround

Create a hold for the first absolute clip and drag it to the end of the 
relative clip. Blend this with the second absolute clip. You should now 
have the correct animation.

Path animation limitations

The following limitations and workarounds relate to path animation.

Geometry popping out of flow lattice

If a transform object with several pieces of geometry grouped under it 
is animated with path animation, and then flow is applied with the 
lattice around the object option, occasionally some of the geometry 
may “pop out” of the flow lattice. 

Workaround

Do one of the following:

• Set the Outside Lattice attribute for the FFD to “All” so that all the 
geometry grouped under the transform object is affected by the 
flow lattice.

• Select the base lattice of the flow’s FFD and scale it a little larger 
until the geometry “pops back” inside the flow lattice.
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Motion Capture & Device Editor limitations

The following limitations and workarounds relate to motion capture and 
device editor software.

setInputDeviceMapping -view command doesn’t work

The setInputDeviceMapping -view command doesn’t work. Device 
coordinates are always aligned with the global axes.
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deformers
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notes

General character setup limitations

The following limitations and workarounds relate to general Character 
Setup software.

Set Driven Key cannot be performed on attributes in a 
character set

Set Driven Key cannot be performed on attributes that are in a 
character set.

Workaround

Take the attribute out of the character by selecting the attribute in the 
channel box and choosing Character > Remove From Character. 

When you delete a top-level character set, Maya no longer 
recognizes its subcharacters

If a character with subcharacters is deleted, and the subcharacters are 
not deleted, the subcharacters will no longer be recognized by the 
Maya UI because it is no longer part of the character partition. 

Workaround

Manually add the characters that are now the top-level characters into 
the characterPartition by typing: 

partition -add characterPartition <subCharacterName>;

Skeletons and Inverse Kinematics limitations

The following limitations and workarounds relate to skeletons and inverse 
kinematics software.

Set Preferred Angle limitation

Using Skeleton > Set Preferred Angle on joints in a chain controlled by 
an IK Handle will appear to have no effect.

Workaround

Create the IK handle after setting the preferred angles of the joints. 
Alternatively, deleting the IK handle and then performing an Undo 
operation to restore it will yield an IK solution that respects preferred 
angle.

mirrorJoint command may not work correctly

The mirrorJoint command may not work correctly if the joints being 
mirrored have child objects that are not joints or end-effectors.
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Workaround

Reparent the child objects somewhere else, mirror the joint, duplicate 
the child objects, and reparent them back to the old and new joints.

Mirroring joints limitation

Mirroring joints with hand-rotated axis does not work correctly.

IK solver may interfere with a batch render

If you have IK handles in your scene that are not being animated, they 
normally follow their end-effectors as the end-effectors move. 
However, when a scene is first loaded into Maya, the IK solver will be 
invoked once which can interfere with a batch render.

Workaround

If you are not using these IK handles for animation (which is likely to 
be the case), delete them. If you cannot delete them, turn off their 
SolverEnable attribute.

These IK handles would normally snap to the end-effector. When the 
scene is first loaded into Maya, the IK handle is then incorrectly 
flagged to be solved. If you are batch rendering, the handle gets 
moved to the end-effector position as defined at the current time in 
the file, for example, frame 1. The solver is then invoked at the frame 
being rendered; the limb tries to reach for the frame 1 position of the 
end-effector. If solverEnable is off or if the IK handle does not exist, 
this will not be a problem.

Deformers limitations

The following limitations and workarounds relate to deformers software.

Deformer set’s weight field for a subd surface vertex member 
blank

The weight field in the Component Editor for a subdivision surface 
vertex member of a deformer set (cluster, skinCluster, or jointCluster) 
may sometimes appear blank, and entering new weight values has no 
effect. 

Workaround 

Pick the cluster handle or joint and select the cluster members by 
invoking the Deform > Edit Membership Tool. The Component Editor 
will now display and edit weight values for the cluster members. If 
you now turn “off” List > Auto Update in the Component Editor 
window, clicking the name of the component in the first column of the 
table will identify the cluster member by selecting it in the modeling 
views.
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Wrap deformer sometimes tears a NURBS patched model

The wrap deformer sometimes tears a NURBS patched model.

Workaround

Global stitch the patch model and then add the wrap deformer.

Wrap behaving unpredictably

If you modify the face or CV count of shapes used as wrap deformers, 
the wrap behaves unpredictably.

Workaround

Remove the shape as an influence object and then add it as an 
influence object again. This will reset the data for the wrap so that it 
will work again.

Snap mode affects transformed CVs

When in snap mode, translate, rotate, and scale of the CVs of a 
deformed object behave unpredictably.

Workaround

Use the Channel Box to set precise translation values for the CVs of 
deformed objects.

Adding a new influence object to a smooth skin

If you add a new influence object to a smooth skin, it will not 
immediately appear in the Component Editor.

Workaround 

Close the Component Editor and reopen it.

Changing the CV count of a deformed object downstream

If you change the CV count of a deformed object downstream (after) 
the deformation, translate, rotate and scale of the CVs of the object 
may affect the wrong CV. Examples of operations that would cause 
this problem are: inserting or removing a knot on a NURBS surface, or 
deleting a polygon face or vertex.

Workaround

Disconnect the message attribute connection between the deformed 
shape and the tweak node. To do this, select the shape and display its 
history in the Hypergraph. You will see a connection between a tweak 
node and the shape. Select the connection and press the Delete key to 
break the connection.
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Reading files containing wrap deformers can be slow

The wrap deformer calculates a great deal of information for each 
deformed CV when the file is read in. This computation can be time 
consuming.

Workaround

Hide the surfaces that are deformed by the wrap. The wrap 
computation will not be done during file read if the deformed surfaces 
are hidden. However, the wrap computation will be done when the 
display of the surfaces is toggled on.

Unpredictable results when changing an object’s topology 
upstream from a deformation

Changing an object’s topology upstream from a deformation causes 
unpredictable results. When you deform an object, Maya generates 
references to some of the object’s components (CVs of NURBS curves 
or surfaces, polygon vertices, or deformed lattice points). 

There are several ways to change the topology (for instance, the 
number of such components the object has) “upstream” of the 
deformations. For example, the Rebuild Curve operation may change 
the number of CVs in a curve, changing the sections or spans 
attributes of a makeNurbSphere node may change the number of CVs 
in the resulting NURBS surface, and the Polygons > Smooth operation 
can drastically change the number of polygon vertices in the 
smoothed object. Unfortunately, Maya does not yet have a way to 
communicate these changes to the nodes downstream in a way that 
allows the “right thing” to happen.

Workaround

If the object being modified is being deformed: Remove the object 
from the deformer’s deformation set, apply the topology-changing 
operation, and then restore the modified object to the deformation set. 
If the deformation was a cluster and you had edited the associated 
percentages, you must repeat that step after changing the object’s 
topology.

If the object being modified is bound as skin to a skeleton: Detach it 
from the skeleton (Skinning > Detach Skin), apply the topology-
changing operation, and then rebind the skin (Skinning > Bind Skin).

If the object being modified is a curve used as a wire curve (for 
instance, it is the “influence object” for a wire deformation): Remove 
the curve from the wire deformer, change its topology, and then add 
it back to the wire.
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Lattices with partial resolution may distort target geometry

The loss of accuracy caused by the Partial Resolution Lattice deformer 
setting may severly distort lattice deformed geometry.

Workaround

Decrease the value of the Lattice deformer’s Partial Resolution 
attribute, or use Full Resolution.

Jiggle deformers may not evaluate properly when used in 
combination with Fur or motion blur

Workaround

Batch rendering of Fur objects and motion blur with the jiggle 
deformer requires the creation of a jiggle disk cache.

Ghosting is not reliable on jiggle deformations

Workaround

Creating a jiggle disk cache will typically allow ghosting to work on 
the jiggle object.
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NURBS modeling limitations

Extend curve on surface may temporarily hang

Extend curve on surface may temporarily hang the system while 
editing the extension distance. 

NURBS primitive cone or cylinder with caps and trimming

If a NURBS primitive cone or cylinder with cap(s) are involved in a 
trimming operation, they need to be created with the Extra 
Transformation option set to on, or the surface for trim will only be 
selectable in the outliner/hypergraph and not in the view. 

Curve on surface using project curve or intersect surfaces with 
history

If a curve on surface has been created using project curve or intersect 
surfaces with construction history enabled, performing delete 
components on such curves before deleting construction history may 
create data loss when saving into a file. 

Workaround

Delete construction history before deleting components. 

Attaching surfaces with the same name not working

Edit NURBS > Attach Surfaces does not work if the surfaces have the 
same name. 

Workaround

Rename surfaces to have unique names prior to using Attach Surfaces.
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Subdivision Surfaces limitations

Weight field for a subdivision surface vertex member of a 
deformer set may appear blank

The weight field for a subdivision surface vertex member of a 
deformer set (cluster, skinCluster, or jointCluster) may sometimes 
appear blank, and entering new weight values has no effect.

Workaround

Pick the cluster handle or joint and select the cluster members by 
using Edit Membership Tool. Use the Component Editor to now 
display and edit weight values for the cluster members. If you turn off 
List >Auto Update in the Component Editor window, clicking the 
name of the component in the first column of the table will identify 
the cluster member by selecting it in the scene view.

Unexpected results with non-proportionally scaled Subdivision 
surfaces

Subdivision surfaces with non-proportional scale and hierarchical 
edits may note behave properly when a rotation is applied to the 
coarse mesh components (including base).

Workaround

Use Modify > Freeze Transformations with the scale option set to 
remove the non-proportional scale from the object in question.

Selecting UV vertices on texture borders in the UV Texture 
Editor

In the UV Texture Editor window, selecting UV vertices that are on 
texture borders may sometimes result in multiple vertices being 
picked. 

Skinning while in Polygon Proxy mode can lead to unexpected 
behavior

When skinning subdivision surface characters, be sure your 
subdivision surfaces are in Standard mode before skinning. Skinning 
while in Polygon Proxy mode can lead to unexpected behavior. 

Converting NURBS sphere to subdivision surface creates 
incorrect normals at poles

If you convert a NURBS sphere to a subdivision surface sphere and 
view it in shaded mode, the poles will appear as dark points (meaning 
the normals are being computed incorrectly). 
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Workaround

Start with a polygonal sphere and convert it to a subdivision surface 
sphere.
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General polygon and games limitations

The following lists general polygon and games limitations and 
workarounds.

Flipped triangle edges may appear incorrect

When flipping polygon edges using 
Edit Polygons > Flip Triangle Edge, the smooth shaded display of 
your edges may look incorrect. The neighboring edges around the 
flipped edges may have incorrect smoothing. 

Workaround 

Use the command 

dgdirty -a; 

or tweak any vertex of the polygon object after flipping the edges. 

UVs not normalized when creating primitives

The Normalize the whole object option in the polygon cube or cylinder 
creation windows (Create > Polygon Primitives > Cube /Cylinder) 
maps textures over each face of a primitive so that the texture covers 
the entire object. However, this option does not normalize the UVs of 
the primatives.

Texture Placement manipulator visibility

When using the Texture Placement manipulator, the manipulator may 
disappear.

Workaround

Middle-click anywhere in the empty space of the scene view to make 
the manipulator reappear.

Maya does not maintain the order of selected components

The global selection list does not preserve selection order of polygon 
mesh vertices, faces, edges. 

Workaround

Use the following script to collect each selected component in an 
array, and then use the array as desired.

global proc selectProc() 
{ 
global string $gSelectedComponents[]; 
string $selC[] = `ls -sl -flatten`; 
if (size($selC) > 0) { 
Maya 6.5 Release Notes

43



8 | Polygons and games
Release notes > General polygon and games limitations
int $match = 0; 
for ($newSel in $selC) { 
$match = 0; 
for ($oneComponent in $gSelectedComponents) { 
if ($newSel == $oneComponent) 
$match = 1; 
} 

if ($match == 0) 
$gSelectedComponents[size($gSelectedComponents)] = $newSel; 
} 
} else { 
clear ($gSelectedComponents); 
} 
int $debug = 1; 
if ($debug && (size($selC) > 0)) { 
print ("Selected components (in the order) ...\n"); 
print ($gSelectedComponents); 
print ("\n"); 
} 
} 

// to load the scriptJob 
int $jobNum = `scriptJob -e "SelectionChanged" "selectProc"`; 

// to unload the scriptJob 
scriptJob -kill $jobNum; 

Material Blend Settings

The display of Color Per Vertex (CPV) Material Blend Settings varies 
depending on scene view Shading settings. In textured and shaded 
mode with Hardware Texturing enabled, Add, Subtract and Multiply 
blend modes will be displayed with slightly reduced quality, while 
Divide, Average and Modulate2X are not displayed correctly. The 
correct result of all blend modes will be displayed by switching to 
High Quality Rendering mode with Hardware Texturing enabled. If 
your graphics card does not support High Quality Rendering mode, 
you can test render using the Hardware Renderer to preview your 
result. In instances where your graphics card may not support High 
Quality Rendering or the Hardware Renderer, you can switch to 
Hardware Shaded mode to preview the blending without textures. 

Poly component convert selection

When you have multiple component types selected and choose a 
polygon action, Maya automatically converts the selection to that 
expected by the action. This automatic conversion has been 
implemented on all poly commands except the following: 

• polyEditUV
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• polyGeoSampler

• displacementToPoly

• untangleUV

• polyUVSet

• polyProjection

• polyNormalPerVertex

• polyForceUV

• polyFlipEdge

• polyColorPerVertex

• polyClipBoard

• polyBlindData

• polyAverageNormal

• blindDataType

• polyCreate

• polyUnite

• polySeparate

• polyBoolOp

• polyWedgeFace

In addition to those corresponding to the above commands, the 
following menu items will also not perform the conversion:

• Extrude Edge

• Extrude Face

• Move Component

• Smooth Proxy

• Duplicate Face

• Extract

polyGeoSampler not working in -batch or -prompt mode

The command polyGeoSampler requires that there be a camera 
selected in your scene in order to work properly in -batch or -prompt 
mode. 

Workaround

Run the command in interactive mode, or run it from a script that first 
selects a camera.
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Bevel Plus limitation

In some rare occasions when Bevel at Start is turned off, undesirable 
results may occur if the end face becomes self-intersecting. 

Workaround

Turn on Bevel at Start, turn off Bevel at End and set the Bevel Depth 
and Extrusion Length to negative values (precede the value with a “-
”). If required, modify the original curve to ensure desired results.

Polygonal faces disappear in shaded mode

When you apply a “freeze transforms” operation on an object, the 
“opposite” rendering option is automatically turned on. This means 
front-faced polygons are culled when in back-face culling mode in 3D 
views. 

When back-face culling is also on in the polygon display options, 
back-faced polygons are also culled. If the object is not selected, all the 
polygonal faces are culled in shaded mode display making it seem as 
though the object has disappeared. 

cp attribute limitation

On polygonal objects, the cp attribute is supposed to represent the 
actual position in local space of a vertex, while the pnts attribute 
represents the tweak value (its offset relative to the rest position). 

The cp attribute is a compound attribute with child attributes named 
xv/yv/zv. When you get the value of the parent attribute, Maya 
incorrectly returns the same value as for the pnts attribute. 

Workaround 

Use the xv/yv/zv child attributes individually instead of the entire cp 
compound attribute.

For example:

polyCube; select -r pCube1.vtx[0] ; move -r .1 .1 .1;
getAttr pCube1.cp[0];

// Result: 0.1 0.1 0.1 // 
 getAttr pCube1.cp[0].xv;

// Result: -0.4 // Real X position (-.5 + .1)

Subdivide and Move Components pick mask modes

Polygons > Subdivide and Polygons > Move Components are driven 
from the pick mask, not the current selection. For instance, if you 
select a face, but the pick mask is set to Edge, Subdivide and Move 
Components will not work and if you open the option window, the 
option window for Edges displays. 
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Also, if the pick mask is set to Vertex or UV, the Subdivide option 
window will not open, since only faces and edges can be subdivided.

Workaround

Make sure the pick mask corresponds to the selection.

Smart Command Settings hard to turn off

Smart Command Settings are difficult to turn off. In some cases if a 
tool has used Smart Command settings, the selection mask or 
selection constraints are not returned to normal when you exit the tool

Workaround

After turning off Polygons > Tool Options > Smart Command 
Settings, you must also select Uninstall Current Settings to delete any 
settings left on by the last tool that was invoked. 

polySeparate command

The polySeparate command fails if the object is invisible.

The error message in this case can be misleading: 

Warning: polySeparate works only on polygonal objects.

Workaround

Make the object visible.

Booleans do not preserve color per vertex and component 
level blind data info

Polygons > Boolean operations do not preserve color per vertex or 
component level blind data information. 

Map UV Border may not find unique border with non-manifold 
geometry

Edit Polygons > Texture > Map UV Border may not be able to find a 
unique border with non-manifold geometry. 

If you have a piece of non-manifold geometry, any particular UV may 
be in more than one border/shell, so it does not uniquely determine a 
flat piece of mesh to relax. Edit Polygons->Texture->Map UV Border 
will find a boundary and map it, but you can't control which one it 
will get. 

Workaround 

Cut the UVs along the non-manifold edges to make sure that they're 
“flat”, or use Polygons->Cleanup to eliminate the non-manifold areas 
first.

Unexpected results with Cleanup when applied to objects and 
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instances simultaneously 

Polygons > Cleanup behaves unexpectedly when applied to an object 
and its instances simultaneously. This usually occurs when Cleanup 
All Objects is enabled. 

Workaround 

Cleanup only the original object; the instance will be cleaned up as 
well as a result.

Selection: All Components sticks in vertex/face selection mode

Setting Selection: All Components on in the pick mask can get you 
stuck in vertex/face selection mode. 

Workaround 

Use the right mouse button to choose the selection type. (Vertex, edge 
and face selection are intended to be mutually exclusive, but there is 
no entry in the component selection menus for vertex face selection.)

Flipping edges from multiple objects

Flipping edges from multiple objects at the same time can lead to a 
crash. 

Workaround

Select and flip edges from one object at a time.

Color per vertex animation not working for polygonal objects 
without history

Color per vertex animation will not work for polygonal objects which 
do not have modeling/construction history. 

Workaround

Introduce some benign construction history (such as a move 
component operation that doesn't actually move anything).

Unexpected results in Cleanup when removing lamina faces 
and non-manifold geometry

In Polygons > Cleanup, combining the removal of lamina faces with 
the removal of non-manifold geometry can lead to unexpected results. 

Workaround

Cleanup the lamina faces first. In many cases, this also eliminates the 
non-manifold geometry.

Texturing and coloring limitations 

The following lists texturing and coloring limitations and workarounds.
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polyColorPerVertex -rem command incorrect when vertex/face 
component selected

The command “polyColorPerVertex -rem” does not work correctly 
when a vertex/face component is selected. You can only remove color 
per vertex for an entire vertex (for instance, for all faces that share the 
vertex).

Best Plane texturing selection limitation

Selection does not work correctly in the Best Plane texturing tool.

When you are prompted to select faces, the selection mask is not set 
correctly so that when you drag-select, vertices are selected. 

If faces are selected from two or more polygonal shapes, only the faces 
from the first shape are actually textured. 

Workaround

• Either select all faces before invoking the tool, or set the selection 
mask explicitly to Polygon.

• Use best plane fit on one shape at time. You can still use vertices 
from a different shape to define the plane.

NURBS To Polygons limitations

The following lists NURBS To Polygons limitations and workarounds.

Fix Texture Warp does not work with NURBS to Poly 
conversion

NURBS to polygon conversion does not take the Fix Texture Warp 
attribute (which adjusts a texture’s UV parameters so the texture does 
not rely on a NURBS object's UV parameterization) into account.

Level of Detail limitations 

The following lists Level of Detail limitations and workarounds.

Threshold values change if children of a level are reordered in 
Hypergraph

If you reorder the children of a level of detail node from the 
Hypergraph, the threshold values change unexpectedly. 

Workaround 

Use the outliner to reorder the children.
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Duplicating a child of a Level Of Detail node fails

Workaround 

Duplicate the object before creating the level of detail, or ungroup the 
object you want to duplicate, duplicate it, and then regroup the 
results.

Blind Data limitations 

The following lists Blind Data limitations and workarounds.

Blind Data Editor coloring and querying limitations

The Blind Data Editor will not properly handle false coloring and 
querying of more than one blind data type with the Continuous type 
enabled. The Blind Data Editor also will not handle combinations of 
Discrete Value colors/queries (including unsigned color/query 
actions) and Discrete Range colors/queries - if a specific value is 
required in combination with a range, use that value for both the Min 
and Max in the discrete range section. 
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Dynamics limitations

Dynamic compound attribute

If you add a dynamic compound attribute to a node with other 
dynamic attributes, and then delete the compound attribute, you will 
not be able to recreate another dynamic attribute with the same name. 

Workaround

Do one of the following:

• Save your scene and reload it. 

• Duplicate the object, delete the original, and rename the duplicate 
to match the original.

(Windows only) Rigid Bodies may behave differently in 
Maya 6.5

As the result of a compiler change, rigid body simulations created in 
previous versions of Maya may behave differently when brought into 
Maya 6.5.

Interactive Playback limitations 

Interactive Playback does not currently work with passive rigid 
bodies. For example, if a passive rigid body is moved while the solver 
is playing, active rigid bodies will only collide with the passive rigid 
body in its original position. 

Shader glow on particles may flicker 

Workaround

1. Increase the particle samples attribute on the render quality. 

2. Increase the resolution parameter on the shader glow node. 

Surface emission from a trimmed surface won’t reflect new 
holes

With surface emission from a trimmed surface, if you add more trims 
or untrim the surface, the emission won't reflect the new holes.

Workaround

Bring up the geoConnector node associated with the emitter, and 
change the tessellation value a little, for instance, from 200 to 201. This 
forces re-tessellation, and the re-tessellation picks up the new trims 
correctly.

Positions of emitted particles incorrect when parent particle 
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hidden

If Particle A is emitting Particle B and Particle A has any animation on 
it, either with fields or emission, the positions of the emitted Particle B 
particles will not be correct if Particle A is hidden. 

Workaround

Keep Particle A visible, but give it an opacity attribute with a value of 
0.

Point and multipoint types w/line smoothing render differently 

A particle rendered “as transparent” shows up differently if line 
smoothing is on vs. when it is off, even with identical opacity values. 

Workaround

Add an opacity attribute to the particle shape. (This doesn't hurt if 
you are turning geometry masking on, since all particles are 
transparent anyway.) Tune the opacity value to get the look you want.

Rigid body keyframed passive to active resets incorrectly

Rigid body keyframed passive to active resets incorrectly if you don't 
freeze transform. 

Workaround

Model your object first, select Modify > Freeze Transformations, then 
set active/passive keys, adding any fields as the last step.

Maya may fail to create rigid bodies on complex NURBS 
surfaces

Maya may fail to create active or passive rigid bodies with the default 
settings on complex NURBS surfaces (for example, long extruded 
surfaces).

Workaround

Increase the Tesselation Factor in the Performance Attributes section 
of the Active or Passive Rigid Bodies Options windows.

Flow effects and curve flow don't work if units not in cm

Workaround

Set the scene units to cm, create a new scene, then reopen original 
scene. 

Limitation when passive rigid body parented to a hierarchy

Passive rigid body parented to a hierarchy may not interact correctly 
with active bodies and constraints
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Workaround

Put the same animation on the passive body, separate from the 
hierarchy.

Expression on “active” attribute may cause evaluation failure

Expression on “active” attribute may cause evaluation failure in rigid 
solver

Workaround

Key the active attribute using the menu items provided for that 
purpose.

File referencing not supported for particle expressions

Workaround

Put your particle expressions in the main file. 

Fields and emitters don't convert particle positions

Fields and emitters don't convert particle positions for non-standard 
units

Workaround

Use standard units. 

Rigid bodies work only with default rotation order

Workaround

Use default rotation order. 

Duplicate, Make Copy Soft option limitation

Duplicate, Make Copy Soft option loses assignments of multiple 
materials on polygonal objects. You may not see the problem has 
occurred until you save and reload the file. This problem does not 
occur with only a single material on the polygonal object.

Workaround

You must re-assign those materials or use the “Duplicate, Make 
Original Soft” option. 

Transparent Blob is not transparent 

Transparent Blob is not transparent when its shader’s RtRefractColor 
is on and ray tracer is off. 

Particles may collide on creation 

Particles may collide on creation when surface emitter is also a 
collision object. 
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Workaround

Reverse the normal speed parameter of the surface emission.

Component Editor refresh limitation

The Component Editor may not refresh automatically after undo/
redo or after external changes such as modifying vertices with a scale 
tool. 

Workaround

Select Load Components. This was an intentional change to bring 
about a speed increase of several orders of magnitude in the editor. 

Soft bodies and particles collide limitation

Soft bodies and particles may not collide well with objects modeled 
using large concave pieces of geometry (for example, the side of an 
outdoor stairway). 

Workaround

Triangulate the geometry.

worldVelocity and aim direction

You cannot use the worldVelocity attribute as an aim direction for 
instances.

Workaround

Keep the particle transform as the identity and use the velocity 
attribute.

Rotate pivot and instancing

Instancing does not handle situations where the rotate pivot is not at 
the origin.

Workaround

See the script, createInstancerPivot.mel in the scripts/unsupported 
directory (under the main Maya install directory). The script contains 
directions for use.

Hardware rendering with motion blur limitation

Hardware rendering with motion blur works only if the multipass 
value is set at least as high as the motion blur value.

Rigid bodies with negative scales and non-zero pivot points

Rigid bodies with negative scales and non-zero pivot points do not 
work properly. Duplicating rigid bodies with negative scales can lead 
to this situation.
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Duplicate Input Graph limitation 

Duplicate Input Graph does not work with rigid bodies.

Workaround

Duplicate Input Graph also duplicates the rigid solver. Most likely 
this is not what you really want to do. If you just want a duplicate 
rigid body running off the same solver, turn off input connections and 
upstream graph checked then duplicate. 

Use the Dynamic Relationship Editor to hook the rigid body up to any 
fields (you can also duplicate fields, if that is what you want to do.) If 
you really do want a second solver, you can make one at that point 
using the standard workflow for that operation (see the Dynamics 
guide for details).

Identical rigid bodies may not collide

Two identical rigid bodies on top of one another may not collide.

Workaround

Scale, rotate, or translate one of the rigid bodies slightly.

Rigid bodies do not recognize non-planar polygons 

Workaround

Triangulate the non-planar polygons.

Copying a rigid body/rigid constraint systems

When copying a rigid body/rigid constraint system, the copied 
constraint does not connect to the copied rigid body.

Workaround

Turn on Duplicate Input Graph in the Edit > Duplicate options 
window.

Revolve limitation when converting to rigid bodies

Revolve can create an inside-out object when the surface is converted 
to a rigid body. 

Workaround

Digitize the curve in clockwise direction, then select the curve and 
select Surfaces > Revolve. Or select Edit Surfaces > Reverse Surfaces, 
then reverse the U direction of the surface/generating curve. 

To visually verify if the surface is inside-out, use single-sided lighting. 
Toggle off Lighting > Two Sided Lighting and toggle on Shading > 
Smooth Shading. The surface will appear dark if it is inside-out.

Particle point render type not hardware rending correct size on 
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some machines 

When render type is set to Points or Multipoint and Line Smoothing is 
turned on, the point size is limited by the graphics card on your 
system. Please see the hardware specifications of for your graphics 
card. 

Ghosting is not reliable on simulated objects such as particle 
simulations, soft bodies, and rigid bodies

Workaround

Creating a disk cache for the simulation will typically allow ghosting 
to work on the object.

Particle system can have inconsistent results between disk 
cache and non disk cache when using rand() in expression

Workaround

Seed the random number. For example, if(frame < 2) seed(1). 

Particles may not evaluate properly when using emit 
command to emit particles

This problematic behavior may be the result of the expression not 
being executed or Maya may be getting the incorrect amount of 
particles during batch mode or prompt mode.

Workaround

Invoke getAttr on the count attribute in the order where the events 
are expected to happen. The getAttr can be called from within a MEL 
script or a regular expression as long as it happens once every frame.

Error messages appear if you modify soft body polygon 
topology

Modifying a polygon object's topology (by editing its upstream 
construction history) after making it a soft body will result in error 
messages. 

Workaround

Adjust the construction history as desired before creating the soft 
body, or delete and recreate the soft body after such changes. 

Rigid bodies have a different playback result after saving the 
scene

The cycle involved with the rigid solver causes a different evaluation 
order. This problem has to do with to the DG evaluation order in a 
cycle. Workaround

Before you save the scene that contains rigid bodies, do the following:
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1 Select Solvers > Memory Caching > Delete.

2 Select Solvers > Memory Caching > Disable.
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Artisan limitations

The following lists Artisan limitations and workarounds.

Paint Vertex Color Tool

Map Import/Export cannot be used when painting vertex faces as 
opposed to vertices. 

Color feedback in Artisan tools

• Although they work the way they should, trimmed surfaces do not 
display color feedback in Artisan tools. 

• Color feedback does not work correctly for Degree 1 NURBS surfaces. 

Using Artisan .tif format texture files in other applications

Using .tif format texture files created in Artisan in other applications 
may produce messages. These messages are harmless and can be 
ignored. 

Exporting attribute maps from NURBS surfaces

Exporting attribute maps will not work correctly for NURBS surfaces 
with a degree other than 3.

Importing subdiv edge selection map

Importing subdiv edge selection map will not work. 

Workaround

Import them as Vertices and convert the selection to edges. 

Error message makePaintable: Missing proper attribute type

Users may encounter the following error when you run Maya 6.5 
using an old userPrefs.mel file. 

makePaintable: Missing proper attribute type 
***** Error: Execution of userPrefs.mel failed. 

The makePaintable commands get saved in the userPrefs.mel file on 
every run of Maya. The commands include internal calls made for 
clusterWeights, skinWeights, etc. as well as commands you might 
have entered in the Script Editor. 

We’ve removed the support for the multiDblArray value from the 
attribute type flag of the makePaintable command so this error is 
displayed. 
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Workaround

You can either delete all the lines and restart Maya or you can edit 
these lines. When entering your own commands you need to use 
multiFloat instead of multiDblArray. 

3D Paint Tool limitations

The following lists 3D Paint Tool limitations and workarounds. 

Unable to paint on textures assigned to layered shaders

You cannot paint on textures assigned to layered shaders. 

3D Paint slow with large textures

If you find a large slowdown in performance when editing larger than 
1K by 1K images then this could be due to insufficient video card 
memory to display textures at that resolution. 

Workaround

You have the option to clamp the maximum size of textures used for 
display by setting the Maximum Texture Display Resolution, which is 
in the Display category of the Preferences window (Window > 
Settings/Preferences > Preferences). It is recommended that you 
restart Maya in order for these settings to take effect.

Painted file texture assigned to multiple surfaces

If you assign a file texture to a shader, assign that shader to more than 
one surface after the texture had already been painted, then enter the 
3D Paint Tool again, the same texture will be assigned to all surfaces. 
No new texture will be created by 3D Paint. 

Workaround

To ensure that unique textures are assigned to the surface, assign 
different shaders to each surface, or make sure you assign all of the 
surfaces to the shader before you begin painting. 

Painting on non-manifold geometry

The 3D Paint Tool does not deal with non-manifold geometry 
correctly. 

Larger textures

On textures larger than 512 (which have to be scaled down to appear 
in the hardware render), sometimes darker pixels appear where there 
are seams in the UV mesh. These do not show in the software render. 
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Texture placement

The 3D Paint Tool ignores any changes you make to texture placement 
parameters. 

Workaround

Convert the texture with modified texture placement to a file texture 
(Edit > Convert to File Texture, in Hypershade) and paint on the 
converted texture.

Changing shader assignment 

Changing shader assignment while in 3D Paint Tool will cause 
inconsistent display. 

Workaround

Exit the 3D Paint Tool before reassigning shaders to the selected 
surface. 

Painting with Fast Interaction

The 3D Paint Tool doesn’t work when Display > Fast Interaction is 
turned on. 

Workaround

Turn Fast Interaction off while painting. 

Switching UV sets 

Switching UV sets while in the 3D Paint tool gives unexpected results. 

Workaround

Exit the tool before switching UV sets.

Paint Effects limitations

The following lists Paint Effects limitations and workarounds.

Pop-up menu on color boxes in Paint Effects Brush Settings 
window

The Paint Effects Brush Settings window has various color slider 
attributes on which you can right-click and a pop-up menu appears. 
Of the items displayed in this menu, only the Color Chooser item has 
any effect. The rest of these items should be ignored as they will not 
change the behavior of the color value. 

Paint Effects Mesh brushes

The interpolation for Paint Effects triangles with Mesh brushes may 
result in distorted textures where the triangle count is low. 
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Workaround

Increase the triangle density on the brush or convert the Paint Effects 
strokes to polygons to render.

(Linux) Wacom stylus and tablet

When you paint strokes in Paint Effects on Linux, your Wacom stylus 
and tablet may have no pressure sensitivity. Select an Artisan tool (for 
example, the Paint Selection Tool) and open the Tool Settings editor. 
Expand the Stylus Pressure section. If the Stylus Pressure options are 
disabled, Maya cannot find your Wacom tablet. Your tablet may be 
installed under the generic name “tablet.” 

Workaround

To fix this, go to the Wacom web site (www.wacom.com) and read the 
product support information for Linux.

Film fit adversely affects Paint Effects

Workaround

Set the film aspect ratio to match the xres/yres, or the value shown in 
the Device Aspect Ratio on the render globals. Be careful not to push 
the film aspect too far (too low in the example file) or the perspective 
will change. 

Renaming strokes with brush springs

If a Paint Effects stroke has brush springs and the brush is renamed, 
the springs may no longer evaluate correctly. 

Workaround

Rename the brush back or edit the expressions to reference the new 
brush name.

Interactive Performance Settings and redrawing strokes

If the Performance Settings for Paint Effects are set to Interactive, then 
immediately following playback, updates to the selected stroke/brush 
will not cause the stroke to be redrawn. 

Workaround

Select some other object, then re-select the stroke. Interactive updates 
will now work.

Strokes rendering white with light fog

Light fog causes Paint Effects strokes to render white. 

Workaround

If the lights in your scene have light fog, turn off "Real Lights" for any 
brushes that have "Illuminated" turned on.
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Turbulence stops working during playback

Once it is turned off, turbulence stops working on Paint Effects stroke 
during playback. 

Workaround

Open the Flow Animation block in the Attribute Editor.

Paint Effects canvas wrapping with Mesh and ThinLine brushes

Paint Effects brushes with a ThinLine or Mesh brushType do not wrap 
when scene or canvas wrap is on. 

Paint Effects multi-processor rendering uses a maximum of 3 
processors

If more than 3 processors are present, only 3 will be used. 

Painting in orthogonal views

Painting in orthogonal views gives unexpected results. 

Workaround

Paint in the Perspective view instead.

Painting on the view plane

Painting on the view plane while in the scene view gives unexpected 
results. 

Workaround

Use the Paint Effects panel to paint on the view plane instead.

Camera depth output setting and artifacts

When rendering Paint Effects, artifacts may occur if the camera depth 
output setting is not set to Furthest Visible Depth. This now the 
default. 

Stroke shadows in IPR

Paint Effects strokes do not show up in IPR, but their cast shadows do. 

Workaround

Hide the strokes before rendering to prevent the shadows from being 
shown.

Light linking

Paint Effects does not support light linking. 

Brushes in Visor

Brushes do not show up in Visor on Windows if your 
MAYA_LOCATION environment variable has backslashes as path 
delimiters. 
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Workaround

Change the back slashes to forward slashes in the environment 
variable (Control Panel > System > Environment).

Field rendering

Paint Effects does not support Field Rendering. 

Workaround

Render with the By Frame value set to 0.5 and interlace in a 
compositing package.

Popping near the edge of a frame

Paint Effects renders can sometimes ‘pop’ where the stroke is near the 
edge of the frame. 

Workaround

Increasing the stamp density and transparency may fix this.

Scaled objects and jumping strokes

On objects that are scaled very large, Paint Effects strokes may ‘jump’ 
when crossing isoparametric lines on the surface. 

Workaround

To prevent this, apply the Freeze Transformations command to the 
object.

Z-up environment

Paint Effects gives unexpected results in a Z-up environment. 

Workaround

Set the environment to Y-up and restart Maya.

Freeze Transformations

Freeze Transformations does not work for Paint Effects strokes. 

Transformations and units

Paint Effects can give unexpected transformation results if the units 
are not set to centimeters. 

Playing back scripts

Parameters that are dynamically set on stroke creation, such as 
pressure values and settings, are not arguments to the stroke 
command itself. Playing back scripts will therefore not exactly match 
what you created. 
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Casting shadows

Paint Effects strokes will not cast shadows if there is no geometry 
within view of the shadow casting light. 

Workaround

Place some geometry in the scene, out of view of the camera, but in 
the view of the light. 

Changing Screenspace Width option

If you turn on Screenspace Width for an object like a tree, the tree size 
is now based on the canvas scale, not the scene scale. 

Workaround

Make the canvas scale equal to the scene scale, and then scale down 
the widths of the tubes, flowers and leaves to the desired levels.

Modifying 3D Paint Tool textures in the Paint Effects canvas

A file texture may not update correctly when you try to use the Paint 
Effects canvas to edit a texture map created with the 3D Paint Tool. 

Workaround

Save the scene before trying to edit the texture in the Paint Effects 
canvas. 

Most recent brushstroke gets re-drawn several pixels off

Using paint effects, some graphics cards may redraw the last stroke 
drawn a few pixels off from where it was. 

Workaround

Before running Maya, set the environment variable 
MAYA_RENDERVIEW_USE_TEXTURES to 1. Maya will then use an 
OpenGL texture call to draw the stroke instead of the normal 
glDrawPixel call.
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Maya Software rendering limitations

The following lists miscellaneous software rendering limitations and 
workarounds.

Changing polygonal topology affects shader assignments

Changing the topology (number of faces) on a polygonal object by 
modifying attribute values on history nodes connected to the object 
can adversely affect shader assignments. This happens if the shader 
assignment is done after the operation that modifies the topology, or 
at the component (face) level (for instance, shaders assigned to 
portions of the object instead of the entire object). 

Workaround

Redo the shader assignment after the topological modifications have 
been completed.

Default drawing of transparent objects

By default transparent objects are drawn in sorted order by the 
distance from the camera to the bounds of each object. 

Workaround

You can change this behavior by issuing the following MEL 
command: 

modelEditor -st 0 <panelName>; 

where <panelName> is the name of the panel containing the 3d 
modeling view. By default the -st value is 1. When -st is set to 0, the 
drawing order for transparent objects is determined by the traversal of 
the dag object hierarchy (which is a depth first traversal). The user can 
rearrange the traversal order by reparenting objects. One way to do 
this is via the Outliner window.

Checkering artifacts on Anisotropic shaders 

Anisotropic shaders may produce checkering artifacts on a 
subdivision surface in software rendering.  

Workaround

Increase the tessellation parameters values to correct the problem.

Seams noticeable during texture baking

Within Maya's model view, texture seams may appear on objects after 
mental ray baking, even when "Fill Texture Seams" is used during 
baking. 
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Workaround

If the Maya viewport is not correctly displaying the baked result; you 
will need to render the scene to view the actual baked result.

Render View Fails to Update

When zoomed in or out, the Render View will occasionally fail to 
completely display a rendered image.

Workaround

Press the 1:1 button to force a refresh of the Render View.

Texture reference objects limitation

Texture reference objects do not work with several things, including 
displacement mapping and subdivision surfaces.

Shadow color has no effect on surfaces

Shadow color has no effect on surfaces assigned to a useBackground 
shader.

(Mac OS X) Alpha channel display

Alpha channel display in image planes do not display properly.

Bump mapping Stencil textures

You must make manual, explicit connections to bump map Stencil 
textures. 

Workaround

Bump map the texture, then manually connect the bumpValue to the 
stencil outAlpha.

Raytracing refractions through a useBackground shader

When raytracing refractions through a useBackground shader, 
artifacts may appear on the useBackground shaded surface. 

Workaround

In such cases, set the “refractions” attribute of the refracted object’s 
shader to off. 

Per-patch shading assignment

Per-patch shading assignment is currently not respected when 
software rendering. 

Optimized scene file location when using the -optimizeRender 
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flag

When using the -optimizeRender flag, the location for the optimized 
scene file to be created is based on the current project defined by the 
preferences or by the MAYA_PROJECT environment variable. 

Workaround

Provide the absolute path where you would like the optimized file to 
be created.

shadingGroupDialogDaemon removed

The command shadingGroupDialogDaemon has been removed. 
scriptJob can be used instead.

mental ray for Maya rendering limitations

This section contains information about the unsupported features, 
software limitations and workarounds, as well as some tips for this 
version of mental ray for Maya.

Unsupported features

Rapid scanline rendering does not support the following features:

• Ambient lights 

• Volume effects, Particles, or Fluid effects 

• Final Gather 

• Raytraced shadows and reflections with motion blur 

• Detail shadow maps

mental ray for Maya does not support the following Maya rendering 
features:

• network rendering: mental ray for Maya's network rendering does not 
correctly render scenes with contour shaders. 

• postprocessing effects: Paint Effects, light glow, optical effects, and 2d 
motion blur

• Field Rendering

Known limitations

The following lists the software limitations and workarounds for this 
version of mental ray for Maya.
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Depth map shadow quality with Rapid scanline rendering

The quality of depth map shadows with Rapid scanline rendering is 
decreased compared to the quality of depth map shadows and default 
scanline rendering.

Workaround

In the Attribute Editor (light shape node), in the mental ray > Shadow 
Maps section, increase the number of Samples.

Advanced filtering and file textures

Scenes that contain custom shaders for volume effects or environment 
shader may not render correctly with advanced filtering (quadratic, 
quartic, etc.) for file textures.

Workaround

Use mipmap filtering, or turn off filtering.

Custom mental ray shaders and importing or referencing from 
Maya 5.0 to Maya 6.x

Imported or referenced Maya 5.0 files containing mental ray shaders, 
with color, scalar, or texture parameters, do not correctly convert in 
Maya 6.x. You may notice shaders becoming disconnected.

Workaround

Open the Maya 5.0 scene file in Maya Interactive, and save it. Then 
import or reference the file in Maya 6.x.

Using Maya Batch Renderer 

When using the Maya Batch Renderer on a remote machine the User 
Account information (i.e. username) must be consistent between the 
machines to ensure that User Authentication will function correctly.

Maya's environment shaders do not work well with IBL

IBL provides UV coordinates to the attached shading network, but 
Maya’s environment shaders do not base their calculations on UVs. 
Maya environments are supported with final gather-based IBL, but 
photon and light emission are unsupported.

A node cycle detection prevents endless loops and crashes 
when translating DG graphs

The performance impact grows with the depth of the visited shading 
graphs. The cycle detection is enabled by default, but you can disable 
it by adding a dynamic attribute nodeCycleCheck (boolean) to the 
render globals node. We recommend using the cycleCheck MEL 
command to detect the cycle in the DG graph to fix it.

mental ray in Maya 6.5 won’t render subdivision surfaces with 
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non-quads in base mesh

Only base meshes made of quads are supported.

Workaround 

To convert to quads, select Subdiv Surfaces > Collapse Hierarchy >  
and set the number of levels to 1.

Partial creases rendering as full creases

Partial creases of subdivision surfaces are not supported in this 
version of mental ray for Maya. They will be rendered as full creases. 

Bump mapping and custom mental ray shaders

Bump nodes are not directly supported by mental ray custom shaders. 

For an example of how to work with bump modes with mental ray for 
Maya, see devkit/mentalray/docs/gettingStarted/
textureShaders_bump.html.

Workaround

Bump effects are still achieveable and involves setting up your 
network to force bump nodes to evaluate during the render. 

To get bump to evaluate, you need to map your bump nodes to one of 
the spare attributes on your custom mental ray material shader (that is 
currently not mapped). 

However, if you want to use all of your material's attributes, then you 
need to pass the texture you really want showing up for that attribute 
and the bump nodes via a mib_color_interpolate node (which behaves 
similar to Maya's ramp texture). 

First, assign your texture to the Color_0 attribute of the 
mib_color_interpolate node and then assign a 
mib_passthrough_bump_map to Color_1 attribute of the 
mib_color_interpolate node. 

Next assign the mib_color_interpolate to any of your material's 
attributes (example: diffuse color) and set the input value of the 
mib_color_interpoloate node to a low value like 0.001 which will force 
the bump to evaluate while allowing you to also use the other texture 
for diffuse color.

Depth map shadows and particle rendering

Depth map shadows and particles are not supported. 

Workaround

Use raytrace shadows.

mental ray for Maya ignores the keyframe animation for the 
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visibility attribute

Workaround 

"Optimize Non-animated Display Visibility" needs to be turned off in 
the Render Global Setting window when visibility is animated. 

Directional light does not work well with Photons

Workaround 

Use a point or spot light instead. Warning messages appear when 
importing scene files in Hypershade

When importing scene files containing mental ray nodes, you may see 
warning messages such as: 

// Warning: 'Draft.message' is already connected to 

'mentalrayItemsList.options'. // 

These warning messages, about pre-existing connections between 
mental ray related node, are harmless and can be safely ignored. 

A warning dialog box also appears when these warnings occur. If you 
are importing many files and wish to avoid manually closing the 
warning dialog box for every file, you may want to use the "file" 
command with "-prompt false".

mental ray for Maya doesn't export the necessary include and 
link statements in the mi file

When exporting scenes containing custom shaders to .mi format, the 
appropriate link and include statements are not automatically written 
to the exported .mi file. As a result, this file will fail to render with the 
mental ray standalone renderer. 

Workaround 

In the "Custom Globals" subsection of the "Custom Entities" section of 
the mental ray Render Globals, you can manually enter the link and 
include statements for the exported file. For example, if your scene 
used custom shaders from the standard contour and physics shader 
libraries, you would specify the includes as

base.mi contour.mi physics.mi

and the links as 

base.so contour.so physics.so

With these custom link/include settings, the resulting .mi file will 
then be renderable.
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Tearing off mental ray for Maya Render menu may crash Maya

If you tear off the Maya Render menu, then load the mental ray for 
Maya plug-in and tear off the mental ray for Maya Render menu, 
Maya may crash. 

Workaround

Close the menu before loading mental ray for Maya.

mental ray for Maya crashes or won’t load when a firewall is 
active

Firewall software may block command ports. When you load mental 
ray for Maya, your firewall prompts you if you want "to allow the 
Maya application to access the internet: IP 127.0.0.1 port 1333." If you 
select no, Maya instantly exits without a warning or error message. If 
you select yes, mental ray for Maya starts up as expected. 

Workaround

If you are using any firewall software, you will need to give 
permission to Maya to communicate on port 1333 in order for mental 
ray for Maya to work correctly. 

Old scenes using mental ray shaders can render differently

mental ray for Maya 6.x provides reasonable default values for mental 
ray shaders. In previous versions, all the mental ray shader 
parameters defaulted to zero. The default values are specified in the 
shader declaration files (base.mi, contour.mi, physics.mi) using 
extended .mi syntax. 

As a side effect, old scenes (scenes created with Maya prior to 6.x) 
using mental ray shaders can render differently if a parameter value is 
set to 0 and its default value has been changed in 6.x. 

Workaround

Run mentalrayShaderDefaultCompat.mel (in maya6.x/scripts/
unsupported) in Maya 5.0. For example, open Maya 5.0, and type the 
following in the Script Editor: 

mentalrayShaderDefaultCompat (“myOldScene.ma”, 
“myOldSceneFix.mel”)

then open the scene myOldScene.ma in Maya 6.x and run the 
generated MEL script myOldSceneFix. This reverts the mental ray 
shader parameter values back to the original settings.

Missing Motion Blur 

When rendering with motion blur, sometimes parts of deforming 
geometry will fail to blur. 
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Errors Caused by Certain Shading Network Connections 

Connections from Input Color Components (advanced shading 
network connection) may cause errors when rendering with mental 
ray for Maya.

Limitation

Connections from Input Color Components: If a connection is made 
between single components (R, G, or B) of input color attributes on 
two shaders or textures, then mental ray for Maya renders will abort 
with error messages similar to:

API  0.0  error  301040: "maya_checker" has no 

member "color1"

API  0.0  warn   302018: type conflict: "color" is 

type color, "maya_checker" returns type struct

The example message was triggered by connecting the color1R 
attribute of one checker texture to the color1R attribute of another 
checker texture.

Workaround

Where possible, replace the connection between individual color 
components by a connection between the entire color attributes. This 
type of connection is supported. 

Custom Text Does Not Work for Interactive Renders

The Custom Text feature is intended for use only with the mental ray 
3.2 standalone renderer. To correctly render a scene containing 
shader/object modifications made using Custom Text, the scene must 
first be exported to .mi format, then rendered with the standalone 
product.

Unsupported File Texture Formats

The following file texture formats are currently unsupported by 
mental ray for Maya:

• Maya BOT files

• certain variants of the TIFF format (including those generated by 
the Maya renderer, and those with LZW compression) 

• Cineon CIN files

• GIF files
Maya 6.5 Release Notes

74



11 | Rendering

Release notes > mental ray for Maya rendering limitations
Workaround

(TIFF,CIN,GIF) For these unsupported file formats, Maya's imgcvt 
image conversion tool can be used to convert the files to a supported 
format such as IFF or RGB. For a complete list of file texture types 
supported by mental ray, see the Rendering with mental ray 
Handbook.

(BOT) There is currently no workaround that will allow Maya BOT 
files to be used in conjunction with mental ray for Maya. mental ray 
does support its own memory-mapped map file texture format, 
however. Standard image files can be converted to this format using 
the imf_copy command:

imf_copy -p <filename>.rgb <filename>.map

See the Rendering with mental ray Handbook for a full description of 
memory-mapped textures in mental ray.

3D Paint issues with mental ray for Maya

When painting a texture with 3D Paint, mental ray for Maya will not 
pick up new paint strokes automatically.

Workaround

Save either the texture being painted or the entire scene before 
rendering with mental ray to ensure that all strokes are rendered 
correctly.

NURBS surface texture warp fix not supported

The fix texture warp attribute on Maya NURBS surfaces is not 
supported in mental ray at this time. It changes the way textures get 
mapped on freeform surfaces to achieve a more realistic look on 
highly deformed surfaces.

Workaround

Triangulate the surface in Maya and use the comprehensive polygon 
texture mapping tools to adapt the uv mapping.

Missing bump/displacement maps when using File Texture 
nodes with mental ray

File textures that are used for bump/displacement mapping are 
usually connected via their outAlpha attribute. If the corresponding 
texture image file does not provide an alpha channel, then the bump 
or displacement effect may be missing when using certain image 
formats. 

Workaround

Enable the Alpha is Luminance property in the Color Balance section 
of the File Texture node.
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Layered Shader not Supported for Global Illumination/Caustics

When using photon mapping effects such as Caustics and Global 
Illumination, any object with a Layered Shader assigned to it will 
behave as if it were a simple grey diffuse object. All of the shader's 
layers will be ignored. Layered shaders do work properly for Final 
Gather effects, but may cause increased render times.

Workaround

Wherever possible, use Layered Textures instead of Layered Shaders. 

Limited Support for Certain Shading Network Connections 

Shading network connections involving dynamic attributes on 
shading nodes, and connections sourced from shading node input 
attributes are supported by mental ray for Maya so long as the values 
passing through those connections are constant for each rendered 
frame. Thus, these connections properly support constant and 
animated values, but not textures. Attempting to pass a texture 
through an input or dynamic attribute on a shading node will result in 
a warning message similar to the following: 

// Warning: (Mayatomr.Nodes) : Unsupported type of 

connection: checker1, current plug value used 

instead //

Workaround

Where possible, connect textures directly to the desired destination, 
rather than passing them through one or more dynamic or input 
attributes.

Tips

Rendering Color and Z-depth

The following is true when rendering to a format other than Maya IFF. 
If rendering to Maya IFF all channels RGBAZ are written to one file. 
When the Depth Channel option is enabled in the mental ray Render 
Globals, mental ray will write out a separate image file containing 
depth information. Z-depth is now written out in IFF format and 
rendered to a separate file that has “Depth” as a suffix to the image 
name, for example, imageDepth.#.iff. 

Depth map shadow settings and volumes (like light fog)

To cast shadows into volumes you have to increase the number of 
volumes samples in the "Render Stats" section of the shape node 
("coneShape1"). This is standard procedure for ray trace shadows. 
mental ray requires you to do the same thing for Dmap shadows. To 
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eliminate Dmap shadow artifacts on the cone boundary try increasing 
"Samples" in the mental ray "Shadow Map" section of the light shape 
node. 

Hardware rendering limitations

This section contains information about the unsupported features, 
limitations and workarounds for Hardware rendering.

Unsupported features

Hardware rendering does not support the following features:

• The -echo flag is not supported for hardware rendering through the 
command line. 

Known limitations

Hi Quality Render and Isolate Select

Isolate Select is not supported with Hi Quality Render. 

Workaround

To remove objects from the view, you must hide them explicitly. 

Surfaces shadowed and lit by directional lights

Scenes with surfaces that recive cast shadows, and which are lit by 
directional lights, appear inadequately lit when rendered by Maya's 
Hardware renderer.

Workaround

To produce a correctly lit surface, use a graphics driver which 
supports OpenGL fragment programs (arbfp1), along with a graphics 
card with one of the following:

• ATI X3 and later chipsets

• 3DLabs P20 and later chipsets

• Nvidia NV30/NV40 and later chipsets

UV texture coordinates missing—display problem

Polygonal objects or portions of polygonal objects with no UV texture 
coordinates appear "stippled" when viewed in hardware texture 
shading mode (hotkey 6). (Stippling does not appear, however, in 
High Quality Rendering Mode.)
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Workaround

Create new UV coordinates by selecting the faces of the object and 
using any of the following tools in the Edit Polygons > Texture menu - 
Planar Mapping, Cylindrical Mapping, Spherical Mapping, Create 
UVs Based on Camera, Normalize UVs, Unitize UVs, and Best Plane 
Texturing. If you do not want to create new uvs you can view the 
object properly by viewing it in shaded mode.

Layered texture file texture resolution display limitation

If you have a file texture as a layer in a layered texture, and a layer 
which is just a color, toggling on or off the color layer results in a 
change in the resolution used to display the file texture.

Lighting on non-proportionally scaled object is incorrect 

Bump mapping and specular highlights on non-proportionally scaled 
geometry will not render correctly compared to software rendering.  

Workaround 

Freeze transforms on the surface to bake the transformation into the 
geometry.

Animation of bump specular highlights pop when zoomed out

Specular highlights on bump mapped surfaces may pop or shimmer 
as the geometry is animated.  

Workaround 

Enable the anti-aliasing options in the hardware Render Globals or 
run a low pass filter (blur) on the bump map texture.

Cube map is not affected by translation and scale

The translation and scale on the environment cube map are not taken 
into consideration by the hardware renderer. The cube map will 
render very differently compared to software rendering. There is no 
workaround for this limitation.  

Hardware renderer doesn't correctly sort transparent polys and 
there are artifacts on transparency mapped objects 

If objects or parts of objects with different shaders have overlapping 
3D bounded regions with respect to the camera, then the transparency 
sorting may not be as expected with respect to a software rendering.  

This is due to the fact that the hardware renderer does not sort on a 
per pixel basis. There are basically two modes for transparency sorting 
in the Render Globals:

• Per Object 

• Per Polygon 
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The axis aligned world space bounding box of objects is used as the 
main criteria for depth sorting with respect the current camera used 
for rendering. 

For “Per Object,” objects are sorted from furthest to closest in depth to 
the camera. The distance measurement is from the center of the 
bounding box to the camera "look from" position. If more than one 
shader is assigned to an object, then each part of the object will have 
its bounding box computed. Each distinct part is called a "shader 
section" and the box, the "shader bounds." If the whole object uses one 
shader then the "shader bounds" are equivalent to the bounds for the 
entire object. The "shader bounds" are sorted from back to front. 

“Per Polygon” provides further sorting refinement. The polygons are 
sorted for each object from back to front. When drawing the depth-
sorted "shader bounds" the polygons are drawn from back to front. If 
this option was not turned on, then the polygons would be drawn in 
arbitrary order per "shader bounds."

Workaround 

For possible better sorting, the you can either:

• Split up polygons of the object into separate objects. 

• Split up single shader regions on single objects into separate 
objects with one shader per object. 

Light image quality on polygons is dependent on UV space 
mapping

Specular highlight quality on polygons will depend on the UV space 
mapping. Care should be taken to give the polygon full UV coverage 
and avoid triangles that are skinny or have little area. One way to fix 
this problem is to select the polygon and then assign an automatic UV 
map by selecting Edit Polygons > Texture > Automatic Mapping. 
Some types of graphics hardware will be more susceptible to these 
problems than others.  

Hardware bump maps are dependent on texture resolution

The bump map appearance is dependent on the size of the mapped 
file texture, or the bump resolution and preset quality in Render 
Globals. If the resolution is changed the bump appearance will also 
change.  

Workaround 

Adjust the bump depth to restore the desired appearance.

Environment reflection maps must be mapped to the reflected 
Maya 6.5 Release Notes

79



11 | Rendering
Release notes > Vector rendering limitations
color channel

Sphere and cube environment maps are only supported on the 
reflected color channel. Assigning one to another channel will 
produce undefined results.  

BOT files are not supported by the hardware renderer 

BOT file textures will be rendered black by the hardware renderer.  

Vector rendering limitations

The following lists the Vector rendering limitations and workarounds.

Resolution settings and Vector rendering

Due to some limitations in Flash technology, (upon which the vector 
renderer is based), increasing the resolution in the Render Global 
Settings does not necessarily produce better results. 

Image is not displayed in browser when Open in Browser is on 

On Macintosh systems vector rendered images are not displayed in 
Internet Explorer 5.2 or lower when the filename is longer than twenty 
characters. 

Workaround

Use a newer version of Internet Explorer or another browser (for 
example, Safari, Netscape, Mozilla).

Vector renderer batch renders blank image when Renderable 
Objects is Render Active

When Render Using is Maya Vector, and Renderable Objects is 
Render Active, Render > Batch Render produces a blank image. 

Workaround

Set Renderable Objects to Render All and hide all objects you do not 
want to render.

By Frame ignored in Vector rendered filenames

By Frame has no effect when using the Maya Vector renderer. 

IPR Rendering limitations

The following lists IPR limitations and workarounds.

General IPR limitations

• IPR does not support raytracing, 3d motion blur, or particles. 

• IPR does not properly handle shadows on objects with a Use 
Background material.
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IPR and group nodes

IPR does not support transformation on group nodes within an IPR 
session when rendering with mental ray for Maya.

Workaround

Start a new IPR session.

IPR and mental ray for Maya rendering and animated 
parameters

mental ray for Maya does not update animated parameters, including 
changes to the time slider, when using IPR (Interactive Photorealistic 
Rendering).

IPR image plane display options

IPR doesn’t respect image plane display options. When updating, IPR 
displays image plane in the background though the image plane is set 
to none.

Workaround

Delete the image plane.

Displaying menu items for IPR in Render View on IRIX vs. 
Windows

When selecting items from the menu in the Render View to shift the 
Attribute Editor’s focus, on IRIX, you shift-click with the left mouse 
button and hold the Shift key to display and choose from the menu. 
On Windows, you shift-click with the left mouse button, but you do 
not have to hold the Shift key to choose from the menu.

Manual feedback from IPR

Manual updates are needed to get feedback from IPR when making 
changes to:

• image planes 

• shadow maps due to light location changing, depth map 
resolution changing, or the auto focus changing 

• tessellation

Workaround

Redo the IPR render after these changes (or select IPR > Update 
Shadow Map).

Using Apply Fog in Post

When using Apply Fog in Post, the results cannot be seen in IPR. 
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Motion blur limitations

The following lists motion blur limitations and workarounds.

General motion blur limitations

• Motion blur does not work with software particles. 

• When you have a light illuminating a moving object, the object’s 
shadow does not blur correctly.

• When you have a moving spot light that illuminates a surface, the 
spot light’s beam moving across the surface does not blur.

• Motion blur is not rendered in raytraced reflections and 
refractions.

Ray tracing limitations

The following lists ray tracing limitations and workarounds.

Raytracing and background color—if ray hits nothing or is 
terminated

During raytracing, if a ray hits nothing, or a ray is terminated due to 
the reflection or refraction limits, the default behavior is to return the 
camera’s background color.

Workaround

If this is not the desired behavior, the camera’s background color can 
be ignored under such circumstances by setting the following 
environment variable:

MAYA_RENDERER_RT_BACKGROUND_COLOR = 0

Raytracing and background color—if reflection (or refraction) 
off

Related to the above release note, when an object’s reflection (or 
refraction) flag is not turned on but the object is set to be reflective in 
the material, the object’s reflection will not be the background color (it 
will be black). 

Workaround

Turn on the object’s reflection/refraction.

Note mental ray for Maya does not respect this environment 
variable.
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Translucence limitation with raytraced shadows

When using raytraced shadows on a translucent object, the 
Translucence Depth parameter will not function correctly unless the 
object's transparency is non-zero. If the transparency is zero, no light 
will ever penetrate through the object, regardless of the Translucence 
Depth value. 

Workaround

Adding a tiny amount of transparency to the translucent object will 
cause all translucence parameters to behave as expected.

Rendering workflow issues

The following lists rendering workflow issues.

Light-linking with plug-in lights

There are some problems involving light-linking with plug-in lights:

• They do not appear in the Light-linking Editor or Relationship 
Editor.

• The query option to the lightLink command does not work for 
plug-in lights. This results in Lights > Select Objects Illuminated 
by Light and Lights > Select Lights Illuminating Objects failing.

Light Linking Editor and deleting lights

The Light Linking Editor sometimes gets confused when you delete 
lights while using it. You may see error messages such as: “Error: No 
object matches name: directionalLight1” after deleting a light. Also, 
the display of which lights are selected can be incorrect after undoing 
a light’s deletion.

Workaround

Deselect everything in a modeling view to clear the editor.

Break Connection on Environment Fog does not delete fog

If you have turned on Environment Fog in the Render Globals 
window, and try to turn it off later using right-mouse button Break 
Connection, the fog remains. 

Workaround

Find the Environment Fog material in Hypershade and delete it.

Hardware shading limitations

The following lists hardware shading limitations and workarounds.
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Projected textures or 3D texture placement on NURBS

Projected textures or 3D texture placement on NURBS surfaces may 
not reflect the correct placement in the views after you transform the 
shapes.

Workaround

Make an insignificant change to any of the texture’s parameters to 
force a proper update after the transformation.

Mapped 3D texture on polygonal object 

If a polygonal object has a mapped 3D texture then hardware 
texturing requires that the surface have a regular grid of unique UVs 
between 0 and 1 for sampling the texture over the surface. 

General plug-in limitations 

• Shader plug-ins and textures plug-ins are supported when you 
use Hardware Texturing. When you use Smooth Shade All mode, 
only the attributes of the following specific names are used: 
diffuse, hardwareColor, color, transparency, incandescence, 
specularColor, shininess. 

• An ambient light will be used to compute the lighting for a shader 
plug-in when you use Hardware Texturing. 

• If a surface does not have an associated shading group or 
materialInfo node, it will appear dark green in color when you 
use Smooth Shade All mode. 

Default texture resolution issues

Default texture resolution issues (which can be modified by switching 
quality in the material’s Attribute Editor) include the following 
limitations: 

• The 2D file texture attempts to use the full resolution (rounded to 
a base 2 number) of the file, but some configurations of texture 
placement will result in the use of a 64x64 hardware texture (for 
example, if you set the Coverage to less than one this occurs). 

• All 2D procedural textures are represented by a 64x64 swatch. 

• All 3D textures are represented by a 32x32 swatch, but a dynamic 
attribute named resolution may be added to configure this setting. 

(Mac OS X) Unsupported image file formats appear in the 
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Hardware Render Buffer window

In the Hardware Render Buffer window > Render > Attributes 
window, unsupported image file formats appear in the Image Format 
drop-down list. The following are the supported image file formats: 
Tiff, Tiff16, SGI, MayaIFF, JPEG, Maya16IFF, Targa, Windows Bitmap, 
MacPaint, Photoshop, PNG, QuickDraw, and Quick Time Image.

When you select another (unsupported) format from the drop-down 
list, Maya renders the image as an .iff file.

Hypershade/Visor limitations

The following lists Hypershade/Visor limitations and workarounds.

Deleting shaders

When deleting shaders in Hypershade, its shading group is not 
deleted. This may result in orphaned shading groups, or worse, 
whatever was assigned to that shading group now does not show up 
in software rendering, and only shows up as dense wireframe in 
hardware shading. 

Workaround 

To get around the latter problem of software and hardware rendering, 
reassign those objects to another shader. 

Showing tabs

When flipping back and forth between showing top/bottom/both 
tabs, the view is not reset, and may mislead the user into thinking that 
whatever was visible in one of the tabs is now invisible. 

Workaround 

To resolve this, set View > Frame All for the problem tab. 

Cameras and views limitations

The following lists camera and views rendering limitations and 
workarounds.

Look Through Selected

Look Through Selected can produce unexpected results if the camera 
is duplicated, or the scene is saved. 

Manipulator undo and two- or three-node cameras

Manipulator undo does not work for two- or three-node cameras. 

View fit problems with joints

View fit has problems with some joints, where it will zoom out too far.
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Problems if camera not proportionally scaled

Problems exist if the camera is not proportionally scaled. The view 
and render will be skewed and manipulation may result in odd 
behavior. 

Resolution Gate and Film Gate incorrectly display

Resolution Gate and Film Gate may not correctly display with non-
standard Film Fit Offsets, when Film Fit is set to Vertical or Fill. 

Workaround

The Horizontal setting works correctly.

Convert to File Texture limitations

The following lists the Convert to File Texture limitations and 
workarounds.

Convert to File Texture and Layered Shader

You cannot use Convert to File Texture on materials that are a layer of 
a Layered Shader. 

Workaround

Disconnect the material from the Layered Shader, do the conversion, 
and then reconnect the resulting file texture to the Layered Shader.

Render Layers/Passes limitations

The following lists the Render Layers/Passes limitations and 
workarounds.

Cannot change the color of objects in a Render Layer

You cannot change the color of objects in a Render Layer. Changing 
the color swatch in the Render Layer Bar will have no effect.

Assigning objects to Render Layers through the Relationship 
editor

Assigning objects to Render Layers via the Relationship editor is not 
recommended since you may inadvertently assign an object without 
it's transform. 

Workaround

Use the Render Layer Bar to assign objects to layers.

Scenes with Fur give unexpected results when using Render 
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Layers

When using Render Layers, scenes with Fur will give unexpected 
results. 

Workaround

Turn off Enable Fur and render the Fur as a separate pass.

Shadow passes and objects assigned with layered shaders

The shadow pass results may be incorrect from objects assigned with 
layered shaders. 

Workaround

Pick one of the shaders that is connected to the layeredShader, and 
connect up that shader's outMatteOpacityR to the layeredShader's 
matteOpacity attribute.

(Mac OS X) Can’t change the color of objects in a Render Layer

You cannot change the color of objects in a Render Layer. Changing 
the color swatch in the Render Layer Bar has no effect. 

Photoshop

The following lists the Photoshop limitations and workarounds.

Converted PSD files do not open in Maya

Some 16 bit PSD files may not open in Maya, specifically those which 
are converted from 8 bit PSD files.
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General Cloth limitations

Texture projections and Cloth

Texture projections cannot be stopped from swimming on Cloth. 
When a projection is used the texture is not locked to the Cloth and 
changes every frame. 

Workaround

Create a poly object, assign the texture and then create a “Cloth 
Object” instead of “Create Garment”.

Cloth files

Cloth files created on one platform (e.g. Mac OS X/Linux) may not 
work properly on another platform (e.g. Mac OS X). 

Workaround

Re-create the cloth by changing stitcher resolution once after opening 
the file on another platform.

Changing resolution of cloth affects texture or modeling edits

If a garment has texture or modeling nodes added downstream as a 
result of tweaks or edits made to the mesh, they may have to be 
reapplied if the resolution of the garment is changed. 

Workaround

Use the default texture coordinates on the garment or reapply the 
edits after the resolution is changed.

Pressing ESC key during Cloth simulation may not work

If you invoke the Cloth simulation by selecting SImulation > Start 
Local SImulation, then pressing the ESC key to terminate the 
simulation may not work. 

Workaround

Select Simulation > Stop Local Simulation.

Simulation stops when screen saver starts

If cloth is simulated interactively, the simulation will stop when the 
screensaver triggers. 

Workaround

Disable the screensaver when simulating interactively. Alternatively, 
set the screensaver timeout to a time longer than the anticipated 
simulation time.
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Cloth initial state may be lost when using referenced files

When using referenced files, the cloth initial state may be lost.

Workaround

In the file you want to reference, save the initial state into a cache file. 
After you load the referenced file, load its associated cache file. 

Skin penetrating cloth

Collision object (skin) can interpenetrate the cloth. 

Workaround 

Interpenetration occurs when the triangle size of the cloth mesh is 
large compared to the collision object mesh size. Using finer 
resolution on the cloth mesh corrects the problem in most cases. You 
can also increase the collision object Offset attribute to avoid 
interpenetration. In cases where intersection occurs when the collision 
object has a thin cross-section, reduce the collision object Depth 
attribute.

Incorrect normals cause solving problems

Tessellated geometry needs correctly oriented normals. If the normals 
are not all consistently pointing outward, the cloth simulation will not 
solve correctly and parts of the collision object may be ignored.

Workaround 

Orient the normals correctly. If the object has already been selected as 
a collision object, you must disconnect it from the solver using Cloth > 
Modeling > Remove Collision Object, reverse the normals, and select 
it as a collision object using Cloth > Create Collision Object. 

Panels must have closed curves

If you open the closed set of curves that define a panel, the panel does 
not tessellate anymore. This can happen if you accidentally move only 
one of the control vertices at the end of the curve. 

Workaround 

Close the curves again by moving the control vertex back to where it 
was. You can undo the vertex move, or you can use curve snap to 
align it with the last control vertex of the next curve. Then select the 
stitcher node connected to the broken panel and enter a new 
resolution value. It does not need to be a different value; this simply 
causes the panel to be rebuilt. 

Dynamics fields require greater magnitude

Using dynamics fields with cloth requires much greater magnitudes 
than you would use with particles. 
Maya 6.5 Release Notes

90



12 | Maya Cloth

Release notes > General Cloth limitations
Workaround 

Try setting magnitude to a value between 100 and 5000. Cloth has 
strong spring forces that hold the cloth together. Any force must 
match that strength in order to have any visible affect. 

Need two curves to make panel 

Panels require more than one curve. 

Workaround 

Do not make panels from one single closed loop curve. Use at least 
two curves. 

Extreme edits 

If you modify the panel curves or resolution an extreme amount with 
Fit to Surface turned on, you can cause Maya to crash. 

Workaround 

If you need to make an extreme edit, make it in a few successive steps. 

Disabling cache affects playback

After disabling the cache, the scene may not play back more than 
once. 

Workaround 

Turn on Enable Cache. Save the file and reload it. 

Changing solver scale resets initial state

Changing the solver scale may cause the initial state of the cloth to be 
reset. It may also cause the placement of mesh constraints to be 
invalid. 

Workaround 

Save a Maya ASCII file. Edit the file as follows: 

After the line: 

createNode cpClothSolver -n "cpSolver1" 

Add the line: 

setAttr ".ss" 2; 

Where 2 is the value of the solver scale. 

Positioning curves for texture placement

When positioning curves to get correct texture placement on cloth 
garments, if any of the curves are duplicated with translational, 
rotational, or scale offset, the texture map assignment gives 
unexpected results. 
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Workaround 

After duplicating curves, select the topmost transform and select 
Modify > Freeze Transformations. This sets the translation, rotation, 
and scale to default and corrects the texture map assignment. 

cpSolver command requires selection list

The cpSolver command does not look at command-line object names 
when using most of its options. It looks only at what is in the selection 
list. 

Workaround 

First select the objects you want the cpSolver command to operate on. 
Then execute the cpSolver command. 

Thickness affected by Solver Scale

The property’s Thickness attribute is affected by the Solver Scale 
attribute. If the Solver Scale is set to 2, then the Thickness will be half 
as large. 

Workaround 

Increase the Thickness attribute as needed. However, use caution 
because values larger than 3 or 4 do not give good results. 

Saving with current frame not at solver start frame

When saving a cloth scene with the current frame at some time other 
than the solver start frame, the current positions of cloth objects will 
not be saved to disk. When you load this scene again, the cloth objects 
will return to their initial positions. 

Workaround 

Save a cache file with your scene. When this scene is loaded into 
Maya, the solver will use the cache file to restore the cloth objects to 
their positions for the current frame. 

Undoing with Fit to Surface

If you remove a panel from a garment that has the cpStitcher attribute 
Fit To Surface turned on, undoing that operation does not restore the 
cloth positions if those cloth positions were the result of a previous 
sub-assembly seaming. 

Workaround 

Do not undo. 

Garment’s initial position not restored

If you delete a cloth object or make edits to the stitched garment that 
cause it to be regenerated such as editing a panel curve or changing a 
resolution, undoing that operation does not restore the garment’s 
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initial positions or cache data. Deleting a cloth with cache data,and 
undoing the delete operation, cloth does not remember the cached 
data position,instead the cloth appears at the origin. 

Workaround 

Do not undo those operations. 

Using same curves in several panels

Cannot use all of the same curves in more than one panel. 

Workaround 

Copy or instance these curves first before making separate panels. 

Cannot transfer garments in batch mode

You cannot use the transfer garment command in batch mode 
(cpSolver -e -t). This may give unexpected results or cause Maya to 
crash. 

Workaround 

Run this command using the Maya user interface. 

Concave faces may cause simulation problems 

If your collision object is a mesh object that is not already triangulated, 
any concave faces may cause problems with the simulation.

Workaround

Triangulate your polygonal surface before making it a cloth collision 
object.

Interactive simulation requires visible window

Interactive simulation requires Maya window to be visible.

Delete Cache may not work

If a cloth mesh that has nodes between the solver and the mesh is 
selected, Delete Cache may not work.

Workaround

If there is only one solver in the scene, select Simulation > Delete 
Cache with nothing selected. If there is more than one solver in the 
scene, select the desired solver, and select Simulation > Delete Cache. 

Cache info not saved out during batch rendering (Windows 
only)

On Windows, if you save a Maya file with cloth simulations and 
cache, Maya saves both the scene file and the cache file in the current 
project’s “Scenes” directory. However, if you first solve the scene, and 
then render the scene from the interface (Render > Batch Render), 
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Maya will save a copy of the scene file in the current project’s 
“Render” directory, (this is correct) but will not save a copy of the 
cache in the “Render” directory (this is not correct).

Ghosting is not reliable on cloth simulations

Workaround

Creating a disk cache for the simulation will typically allow ghosting 
to work on the object.

Cloth constraint limitations

Create mesh constraints at solver start frame

If mesh constraints are not created when time is at the solver start 
frame, bad simulations can result. 

Workaround

Either make the mesh constraint at the solver start frame, or make 
sure that you set the current time to the solver start frame when you 
delete cache. 

Cache not deleted when adding/deleting constraints

When you add or delete constraints, the cache is not automatically 
deleted. 

Workaround 

Delete the cache manually using Cloth > Simulation > Delete Cache. 

Cloth stops solving or hot keys and marking menus lost

After simulating cloth with mesh constraints, if you change the 
collision offset or depth on the collision object that the mesh constraint 
is attached to, cloth stops solving. On Windows, you may lose your 
hot key capability and marking menus. 

Workaround

Open the file with mesh constraints and do not simulate. Change the 
collision offset or depth. Save the file and reopen it. If you lose your 
hot keys or marking menus, save your file and restart Maya. 

Improper mesh constraint changes halt Solver

If the collision object is removed and added again when the collision 
offset or depth is changed, the mesh constraints that tie a garment to 
the collision object are not properly updated. As a result, the Solver 
halts.
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Transferring garment between solvers loses mesh constraint

If you transfer a garment from one solver to another, you lose your 
mesh constraints. 

Workaround 

Transferring garments does not transfer the cloth collision objects, 
which the mesh constraints need to connect to. You must recreate the 
mesh constraints again. Select the cloth vertices (or curves) and the 
new collision objects, and select Constraints > Mesh. 

Cloth and button constraints don’t work in cloth objects

Cloth constraints and button constraints do not work in cloth objects 
(cloth created from mesh objects). 

Workaround 

For these types of constraints, use cloth garments created from panels. 

Cloth drag control limitations

No command to delete drag control

There is no command to delete a drag control. 

Workaround 

To delete the drag control, select the shuttle. Use the up arrow to 
select the parent transform and press the Backspace key. 

Drag control may spin on axis

When moving or rotating the end locator on the drag control, the 
shuttle may spin on its axis in an unpredictable manner. 

Workaround 

In these cases, select only one cloth vertex. This prevents the cloth 
from becoming twisted. 

(Linux) Drag control not solving correctly

The Cloth drag manipulator may not solve correctly on some systems.

Cloth solver limitations

Changing solver’s start frame

When changing the solver’s start frame, the solver may not start 
simulating at the correct frame. 
Maya 6.5 Release Notes

95



12 | Maya Cloth
Release notes > Cloth solver limitations
Workaround 

After changing the solver’s start frame, rewind to the start frame and 
delete the cache (even if you don’t have one). This resets the solver so 
it starts simulating at the correct frame. 

Setting the .doSimulation attribute on solver causes problems

Do not set the internal attribute “.doSimulation” to start/stop the 
solver. 

Workaround

To start a local simulation from a MEL script, use the command:

performCloth startSimulation

For simulation during playback, simply playback the animation with 
the correct simulation start frame set on the solver.

Cascading Solvers

If solvers are cascaded (the cloth output of one solver is used as a 
collision object for another solver) and the downstream solver has 
frame samples set to a value greater than one, then the computation of 
the cloth collisions may not be correct. 

Workaround

If frame samples on the downstream solver is greater than one, make 
sure the upstream solver solves first or the data from the first solver is 
cached.

Unable to access cpSolver node through geometry

Certain Cloth operations such as delete cache and set initial state may 
give the error message: 

Error, must select a cloth object to operate on

if more than one cloth solver exists in the scene, and the cloth 
geometry has non-cloth construction history, such as an extrude node. 

Workaround

Explicitly select the cpSolver of interest through the command line or 
Outliner and then perform the operation.
Maya 6.5 Release Notes

96



13 Maya Fur
Release 
notes

General Fur limitations

Fur attached to Cloth

If Fur is attached to a Cloth shape and the Solver Scale value is 
changed, the Equalizer map will be generated at the initial position of 
the Cloth shape even if you specify a different Use Frame. 

PolySmooth node causes Fur to flicker

If pre-Maya 6.5 files have polygon objects with Poly Smooth applied 
after skinning, and the Smooth UVs option turned on, there will be 
flickering in the animation of rendered Fur, or the motion blur. 

Workaround

To correct this, execute setAttr smoothNode.ma 1; in the Script 
Editor and turn off Smooth UVs in the smooth node. 

This does not happen for scene files created in Maya6.5, as long as the 
smoothUVs is turned off.

Fur and render layers

Fur cannot be assigned to a different render layer than the surface to 
which it is attached. If this attempted, Fur will render on the layer to 
which the surface is assigned, and not on the layer to which the fur is 
assigned. 

Using Chord Height Ratio can cause Fur to flip

Fur that is applied to a NURBS surface,for which Use Chord Height 
Ratio has been turned on, may flip and point in the opposite direction 
on some frames of a multi-frame render. The Chord Height Ratio 
attribute is located under Secondary Tessellation Attributes in the 
Advanced Tesselation section of the Attribute Editor. Confirm that 
Use Chord Height Ratio is not turned on before rendering. 

Fur doesn’t recognize volume light

Fur does not recognize volume lights - light emitted from a volume 
light will have no effect on the fur render. 

Referencing scenes with linked rotation fur attractors 

Scenes with fur attractors with linked rotations will not work properly 
with file referencing. 

Trimmed surfaces don't tessellate consistently in Fur 

Animated trimmed surfaces can tessellate differently from frame to 
frame, causing Fur to appear to crawl over the surface. 
Maya 6.5 Release Notes

97



13 | Maya Fur
Release notes > Limitations when rendering Fur in the Maya Software renderer
Workaround 

Avoid the use of animated trimmed surfaces with Fur. Convert to 
polygons if possible. 

Rendering high resolution 

Fur runs out of memory when you render at 8K x 8K or higher 
resolution. There is no workaround. 

Increasing the intensity of lighting has no effect on diffuse 
component of fur 

In a scene in which the intensity of the lights exceeded 1.0, rendered 
fur would never be brighter than the diffuse and specular colour 
values defined for the fur. One would expect the rendered fur to 
become increasingly brighter as the lighting increased. This is not only 
logical, but also consistent with how other renderers, including the 
Maya Renderer, behave with identical lighting and material 
assignments. In order to make this fix, a change in the shading 
calculations for rendering fur was implemented. The effect is that fur 
rendered with the Maya 6.0 and higher may look different compared 
with previous versions. If you want to maintain compatability, define 
the environment variable MAYA_FUR_LIGHT_CLAMPING. 

Limitations when rendering Fur in the Maya 
Software renderer

Fur shadows and Dmap Auto Focus

Fur Shadows can be incorrectly placed when Dmap Auto Focus is 
turned on. We suggest you turn off Dmap Auto Focus for all 
spotlights that have Fur Shadow Maps enabled, and instead set the 
Dmap Focus value to Cone Angle + (Penumbra * 2). 

Degree 1 NURBS surfaces tessellate extremely highly

Degree 1 NURBS surfaces produce extremely heavy geometry when 
tessellated for Fur, thus taking longer to process and producing large 
intermediate files. 

Workaround 

Convert the geometry to polygons. 

Fur does not render correctly in orthographic views

Fur renders at an incorrect size in the orthographic views in the Maya 
sofware renderer.  

Workaround

Render Fur in mental ray.
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Fur does not support Field Rendering

If Field Rendering is turned on in Maya, Fur will ignore it and render 
frames. 

Workaround 

Render with the By Frame value set to 0.5 and interlace in a 
compositing package.

Fur does not render at all if the camera is scaled negatively

Fur cannot be rendered with a negatively scaled camera.

Fur renders as a grid when a spotlight has a Penumbra Angle

Fur may render as a grid when a spotlight with a shadow map has a 
Penumbra Angle. 

Workaround

Set the value for Penumbra Angle to zero. Alternatively, increase the 
size of the shadow map until the grid artifacts disappear.

Fur does not support any of the 16 bit image formats

Fur does not support any of the 16 bit image formats. 

Workaround

Fur will be correctly composited when rendered to a 16 bit file format; 
however, the Fur pass itself will still be 8 bit. Set the rendered image 
format to a supported image format.

Or render in mental ray.

Using spotlight penumbras and drop-off with fur shadowing 

Although fur shadow maps can be used with spotlight penumbras 
and drop-off, the fur shadows are not affected by these values, so 
there is no fall-off to the fur shadow. The fur shadows may look too 
sharp at the edges. 

Fur does not support texture mapped lights

Fur does not support texture mapped lights. 

Workaround

Render in mental ray.

Using Chord Height Ration can cause Fur to flip

Fur that is applied to a NURBS surface for which Use Chord Height 
Ratio has been turned on may flip and point in the opposite direction 
on some frames of a multi-frame render. The Chord Height Ratio 
attribute is located under Secondary Tessellation Attributes in the 
Advanced Tesselation section of the Attribute Editor. 
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Workaround

Confirm that Use Chord Height Ratio is not turned on before 
rendering. 

Maya may run out of memory when rendering Fur with very 
large shadow maps

Rendering Fur with very large shadow maps can cause Maya to run 
out of memory. 

Workaround

Reduce the size of the shadow map and/or the Hairs/Pixel value for 
Shadow Map Rendering in Fur Globals. 

Limitations when rendering Fur in mental ray 
for Maya 

Fur on instanced objects not rendering

Fur cannot be rendered in mental ray on instanced objects if Group 
Under > New Group was selected in Duplicate Options. 

Motion blur not working

If the Segments attribute is keyframed, motion blur won’t work in 
mental ray.
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General scene limitations

The following limitations and workarounds relate to general scene issues 
with Maya Live.

Errors if you open a file before loading Maya Live plug-in

If you open a Maya Live file before loading the Maya Live plug-in you 
get errors. 

Workaround

Load Maya Live plug-in before starting work in Maya Live.

Unexpected results when solving for a camera without tracking 
data

Trying to solve for a camera without any tracking data may cause 
unexpected results on IRIX. 

Workaround

Make sure you have valid track data first.

Resizing Live window

Some Maya Live functionality goes out of view when you resize the 
window to a smaller dimension.

Workaround

Use Maya Live in its full screen display for all options to be accessible.

Save changes prompt

Choosing Scene > New Matchmove sometimes prompts you to save 
changes—even if you have not made any changes in the scene. 

Setup limitations

The following limitations and workarounds relate to setup issues with 
Maya Live.

Display of Softimage image files

If the Use Cache check box is turned off, Softimage image files that 
lack the .pic extension will not display. 

Workaround

Do one the following: rename images to include .pic extension, 
convert to another format, or turn on the Use Cache check box on the 
Setup Cache control panel. 
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Image plane streaks

Occasionally, images do not display correctly on the image plane and 
the pixels on the right side of the image appear as streaks. 

Workaround

This problem occurs when there is not enough texture memory on the 
machine. Open the Setup Cache control panel and choose None in the 
Texture Method parameter. 

Track limitations

The following limitations and workarounds relate to track issues with 
Maya Live.

Deleting track points

If you undo the deletion of a track point that was used in a solution, 
only the associated 3D locator reappears. 

Workaround

Choose Edit > Undo again to bring back the track point.

Manipulating track boxes

You may have difficulty selecting and resizing track boxes in the 
pointCenteredCamera view panel. 

Message from positioning track boxes

When you position a track box, the following message appears in the 
Script Editor: 

// Undo: dragTrackedPoint_doDrag //. 

Workaround

Ignore the message. 

Refresh of track point names

When you change the name of a track point or a survey constraint in 
the control panel, the label name does not change in the view panels.

Workaround

Wait for the next time the view panels refresh. 

Deselected Track Box Tool

Saving your scene deselects the Track Box Tool.

Workaround

Re-select the Track Box tool if you want to drag a point.
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Ready-to-Solve bar remains red

When you prepare to solve for object motion (using the As Object 
checkbox), the Ready-to-Solve indicators in the Track Summary may 
remain red. This occurs because the Ready-to-Solve indicators are 
based on camera solvability.

Workaround

Ignore the red indicators and continue with the Solve task. 

(IRIX only) Track point appears offset

For O2 systems, the track point appears offset in the shotCamera 
view.

Solve limitations

The following limitations and workarounds relate to solve issues with 
Maya Live.

Undo of Start, Continue, or Refine

Errors occur if you undo the Start, Continue, or Refine step. 

Workaround

Delete the resulting solution instead of choosing Edit > Undo. 

Root Frame solver failure

Occasionally, the Root Frame solver fails and the following message 
appears in the Script Editor:

// Error;  // Exception. // 

// Error;  // Solve Failed. //  

Workaround

Click Solve or Start again and the solver will work. 

Playblast frame range

The Playblast button on the Solve control panel plays the entire frame 
range rather than the frames specified in the Solve control panel. 

Workaround

Select the frame range in the Time Slider bar instead.

Survey constraint Variance fields

LThe solver performs poorly if you enter a value of zero in any of the 
survey constraint Variance fields. 

Workaround

Avoid entering zero in the survey constraint Variance fields. 
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Fluid Effects limitations

Fluid texture not updating

A fluid texture does not update if not connected on outColor.  When 
rendering in mental ray if the fluid is only connected on outAlpha, it 
does no t update.

Workaround

Insert a luminance node between your fluid texture and the shader.

Surface shaded 3D fluid with Opacity Texture looks different in 
software render

If the dropoff shape is off, or the edge dropoff is 0, and your 3D fluid 
has density (greater than the surface threshold) in the boundary 
voxels, you won't see an outside boundary in hardware draw.  

Workaround

If you need to see the outside boundary in the hardware draw, set the 
dropoff shape to cube, and the edge dropoff to .01.

2D texture collision missing some areas

The fluid doesn't enter some regions around the collision object. 

Workaround

Triangulate the poly mesh explicitly using Polygons >Triangulate. 

Fluid object doesn't render in the exported file

If you exported a fluid with inputs off, you may end up losing the 
fluid shading connection to itself, and the fluid will not render. 

Workaround

Open Hypershade,  assign the fluidShape to itself and it will render 
again.

Fluids cache nodes may be named incorrectly

If you create a cache or initial state for a referenced fluid or a fluid in a 
namespace, the cache nodes will be named incorrectly. For example, if 
you create a cache for fluffy:fluidShape1, the cache node may be 
named fluidShape1.

Workaround

Rename the cache node to initialState_fluidShape1 or 
cache_fluidShape1 as appropriate.
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Referenced file initial state cache may be modifiable from 
parent file

If your referenced file has an initial state cache, you can modify it 
from the parent file.

Workaround

Don’t modify it—either by painting or save initial state (unless you 
really mean to).

Floating object animation limitation

Floating object animation only works correctly if units are in 
centimeters.

Workaround

Look at the extra attributes on the associated locator shape, and 
modify to compensate for the change of units. The scene scale is 
normally used to match the ocean shader scale, but it can also be used 
to compensate for the units relative to centimeters. Or you can modify 
gravity, or some of the other physical constants to get the desired 
motion in your units.

Fluid reaction speed not normalized against time step

Fluid reaction speed is not normalized against time step so if you 
change the frame rate or the sampling, the reaction rate will change. 

Workaround

Scale the reaction speed by the corresponding change. For example if 
it was 30 frames/sec and is changed to 15 frames/sec, multiply the 
reaction speed by 2. If doing a 2 times oversample cache of the fluid, 
multiply the reaction speed by 0.5. For a 2 times undersample 
multiply the reaction speed by 2.

Alpha in image plane expands when used with volume fluids

Alpha in image plane expands when used with volume fluids. 

Workaround

Make a second render.

1 Set the colorGain to zero and the color offset to 1 in the image plane.

2 On the fluid node set the Color ramp to all black and then set the 
Incandescence ramp to white.

Different blending cutoff in attribute presets for multis than 
strings, enums

If you apply an attribute preset with blending for a node that has 
ramp attributes and there isn’t a one-for-one match between the 
entries on the corresponding ramps, you may get unexpected results. 
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If these results are not satisfactory, you may have to adjust the results 
by hand. If you undo this kind of blend, you may end up with an 
extra index entry with a position and value 0. If so, delete the extra 
entry. 

Ocean Shader: How do you create a tiling looping texture from 
it?

Here is a more detailed recipe for looping an ocean: 
LOOP_FRAMES = number for frames after which animation repeats. 

1 Create an ocean or ocean shader. Set the numFrequencies and 
waveHeight both to zero so that the ocean is totally flat and more 
optimal to render.

2 Map the oceanShader waveHeightOffset with an ocean 
texture..asProjection = ON and newTexturePlacement OFF. On the 
projection set the rotateX to 90.

3 Map the colorOffset of this texture with another ocean texture.. 
asProjection = OFF and newTexturePlacement = OFF

4 Animate the time values of the two ocean textures such that the start 
of one is the same as the end of the other.

In the time field on oceanTexture1 type:

= frame/30   (the time parameter generally expects seconds, not 
frames)

In the time field on oceanTexture2 type:

= (frame-LOOP_FRAMES)/30

5 Keyframe the waveHeight on the two textures to do a cross dissolve:

oceanTexture1 frame 1 = desired height, frame LOOP_FRAMES = 0

oceanTexture2 frame 1 = 0, frame LOOP_FRAMES = desired height

The ocean animation should now loop across the number of frames 
specified by LOOP_FRAMES above. For it to work the two ocean 
textures must have identical values (apart from the wave height and 
time). With this method you cannot preview the displacement of the 
ocean using the heightfield node (convert displacement to poly will 
work). Also buoys and boats will not animate with wave height 
(texturing on the ocean shader is currently not taken into account for 
these effects).

Volume light Emit Ambient attribute not updating in IPR

When you select Emit Ambient with IPR running, you won't get an 
update. 

Workaround

Reselect the area or change another attribute to update the render. 
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Multiple processors for fluid rendering may result in artifacts

When using four or more processors for fluid rendering, you may 
experience artifacts. 

Workaround

Reduce the number of processors to four or less and try again.

Texture does not return to its original position

If your Texture Coordinate Method is set to grid and you are painting 
your fluid with autosave on, the texture does not return to its original 
position. 

Workaround

Rewind, change coordinate method to fixed then back to grid again. 
Avoid saving unwanted grids, make sure that your saveInitialState 
options are set to indicate which grids should be saved. 

Unexpected results when self shadowing on a surface 
rendered fluid

When self shadowing on a surface rendered fluid, you may get 
unexpected dark regions and artifacts. 

Workaround

This only happens if the fluid has no transparency. Increase the 
quality until the artifacts disappear. Alternately, set the transparency 
to a non-zero value and it behaves as expected. 

Hardware display issues with Node Caching

When Node Caching is turned on, you may get unexpected results in 
the hardware display. 

Workaround

Don't turn on Node Caching for Fluid Effects. If you did, turn it off, 
save your file, and restart Maya.

Fluid texture placement mapped to spotlight

When a Fluid texture placement is mapped to a spotlight it may be 
upside down. 

Workaround

Set the rotation on the texture placement node to turn it the right way 
around.

Depth buffer inaccurate for surface fluid

When rendering a fluid with depth output and a surface style fluid, 
you would expect the surface to appear correctly in the depth buffer, 
especially if the fluid surface transparency is zero. By default nothing 
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will appear in the depth buffer. You must set the camera depthType to 
the closest visible depth to see the fluid in the depth output. However 
the depth value will be the near intersect with the fluid bounds, rather 
than the actual depth of the blobby surface. This could create 
problems for composites with objects (or paint effects) within the fluid 
bounds. 

Workaround

You can get closer to the correct depth by enabling 
volumeSamplesOverride and increasing the volume samples on the 
fluidShape. Note this may create artifacts with surface type fluids and 
it will take longer to render.

Fluid wireframe draw (particles) does not work if voxels too 
small

If the voxel resolution is set low, nothing appears in the Fluid 
wireframe draw (particles). 

Workaround

Use shaded mode or rectangles.

Can't create partial presets if node has multi attributes

You may want to edit the preset file so that it only contains a subset of 
the node's attributes, but when applying a preset to a node with multi 
attributes, it empties out all the multis first, and then adds entries to 
the multis from the preset. Do not alter these files, particularly the 
entries for any multi attribute, such as ramps. 

Convert Fluid to polygon full of holes with smooth 
interpolation

When converting a Fluid to a polygon with smooth interpolation, you 
will most likely get holes in the mesh. 

Workaround

Use linear interpolation and then average the vertices, or, with smooth 
interpolations, using fillHole will deal with these holes except when 
the boundary has non-manifold vertices. In this case we recommend 
increasing the threshold until the geometry is no longer non-manifold. 

Surface rendered 2d fluid image is not consistent with Render 
As display

A surface render of a 2d fluid may not look like a fluid in Display As 
mode. 

• The drop off shape for the cone (and double cone) isn't capped, so 
you still end up with the ends open. This is intentional.
Maya 6.5 Release Notes

109



15 | Maya Fluid Effects
Release notes > Fluid Effects limitations
• In a 2D fluid, not enough triangles are generated along the depth, 
so in a deep 2D fluid, the sphere will look like a cylinder and the 
cone will look like 2 cylinders.

• You will get ribboning if your drop off shape is off, or the edge 
dropoff is 0, whatever the shape. 

Noise and volumetric objects

When using 2D textures on volumetric objects, they must be used as 
projections. 

Older presets are not removed when Maya uninstalled

Uninstalling Maya does not remove the presets folder (in case you 
have added your own presets to it). So if you have previously 
installed an older version of Maya 4.5 (for example, if you are a beta 
site), some old presets which no longer work correctly may remain in 
your new install. 

Workaround

Manually remove the presets folder or just the unwanted presets from 
your install location before re-installing Maya.
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Hair limitations

IK solver may crash Hair render

If your mode has dynamic curves that affect an IK solver, it may crash 
when rendering in mental ray on Linux. 

Workaround

Bake the IK before rendering and make sure that the IK solver is not 
enabled.

3D motion blur on Hair 

The thinline brushtype used by the internal default brush for hair 
does not support 3D motion blur. 

Workaround 

You can assign a Paint Effects brush to the hair system and use the 
Paint Brush Type (Brush Type = Paint). Keep in mind rendering will 
be slower with the Paint Brush Type and also the hairs may appear 
too thick when viewed from a distance. 

Simulation rate problems due to over and undersampling

Simulation rate does not affect hair solver oversampling, and 
undersampling dramatically changes the speed of the motion. 

Workaround

Do not over or undersample when caching hair and do not change the 
playback rate. If you change your time units, you may need to change 
the dynamic properties of your hair system to compensate.

Lock Length not working with clusters

Lock curve length does not work with cluster or other deformers. 

Undo not working when using Lock Length

With Lock Length, undo does not return curve to original position. 

Note 2D motion blur works with hair and the ThinLine Brush 
Type.
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Setting Rest or Start curves from Current on referenced hair 
system doesn't work

Setting Rest or Start curves from Current on referenced hair system 
doesn't work. 

Workaround

Modify Rest or Start curves in the referenced file instead.

Problems with non unique hair curve names and namespaces

If you import multiple hair systems with the same curve names usign 
namespaces, set Rest Position and set Start Position will be unable to 
distiguish the curves. 

Workaround

Although we generally encourage the use of namespaces, in this case 
it may be better to import hair with prefixes to resolve clashing 
names.

Gravity not working with Hair

Gravity doesn't work well with Hair in Z-up system. 

Workaround

Use a gravity field instead of the built in gravity

A default dynamic curve behaves differently at each end

The tip point lock locks to the end CV position, but not to end 
segment direction. 

Workaround

Apply a transform constraint at the end of the hair.

Hair jittering with collision constraint

If your collide sphere constraint is non-proportionately scaled so that 
one dimension is much thinner than another, stiff hair will jitter when 
touching the constraint. 

Workaround

Reduce the stiffness until the hair stops jittering or make the 
constraint more uniform in scale.

Note Lock Length is intended for use while transforming CVs. It 
is not currently supported in conjunction with other 
animation techniques. You may wish to save before editing 
your curve with Lock Length turned on.
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General Maya limitations & workarounds

The following limitations and workarounds relate to general Maya issues.

Audio files may cause Maya to hang

When using imported audio files in Maya it is inadvisable to have 
background applications running that use audio capabilities.)

Odyssey graphics cards and depth buffer visual

The Odyssey graphics cards can be set up such that they may not 
provide a RGBA double buffered with depth buffer visual. This is 
usually the case when the Display settings are incorrect, for example, 
8-bit frame depth, or not enough memory on the card to support the 
higher resolutions. 

The Shaded display may appear incorrect as there is no depth buffer. 
All the surfaces are displayed in the order they are drawn.

Workaround

Set up the display parameters (setmon/xsetmon) so that there is an 
RGBA 8888 double buffered 24-depth visual as shown by glxinfo. Set 
frame depth to 16 to get more visual choices.

It is also possible to configure Maya by using environment variables 
to change the default parameters used to ask for the visual.

setenv MAYA_ASK_DEPTHBUFFER yes

setenv MAYA_ODYSSEY_8888 no

The values used don't matter, just the fact that they are set to 
something. Use unsetenv to undo the effects of these variables

Opening Maya Unlimited scenes using Maya Complete license

If you run Maya using a license for Maya Complete then open a scene 
that contains nodes that are restricted by licensing to Maya Unlimited, 
you may see warnings of the form:

// Warning: file: …/30Sectest.ma line 63: 

Unrecognized node type 'something'; preserving node 

information during this session. //

These warnings can be safely ignored. All information in the Maya 
Unlimited nodes will be properly imported into Maya Complete and 
written out again correctly when the scene is saved. 
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If these licensed nodes came from an Unlimited plug-in (for instance, 
Maya Cloth or Maya Fur) when the scene is written out again by 
Maya Complete the scene file forgets that it needs Maya Cloth or 
Maya Fur to load properly. 

Workaround

Load the Maya Cloth or Maya Fur plug-ins manually in Maya 
Unlimited before loading the scene file. 

Duplicated objects not assigned to a duplicate layer

When duplicating objects with the upstream option set, the options in 
the layer creation option box (right-click layer bar New Layer, or 
Options in layer editor) are respected. 

If the Assign to Current Layer option is specified, the duplicated 
objects will not be assigned to a duplicate layer, but will instead be 
assigned to whatever layer is current. The layer itself will still be 
duplicated in this case but will remain empty. 

Script filters don’t invoke filterChanged callback

Script filters don’t invoke filterChanged callbacks when script changes, 
for example, if you create an item filter like this: 

    itemFilter -byScript userScript filter1;
If you modify the script, you will not be informed that the filter has 
changed.

Workaround

Reassign the same script to the filter to trigger the workaround.

    itemFilter -edit -byScript userScript filter1

Maya leaves UNIX shell key repeat turned off

Occasionally, Maya will leave your UNIX shell key repeat turned off.

Workaround

Use the xset UNIX command to turn it back on:

    xset r on

Marquee component selection in shaded mode

In shaded mode, a marquee selection will select all components inside 
the selection rectangle, even if they happen to be hidden by the 
shaded surface. In other words, shaded selection behaves the same as 
wireframe selection for components.

Editing shading group connections manually

It is not recommended that you manually try and edit the shading 
group connections.
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Workaround

Instead, always use the higher level interfaces like Hypershade and 
shading groups editor to ensure the connections do not become 
inconsistent which will result in the surface not appearing when 
rendered.

NURBS surface does not appear when rendering

If a NURBS surface is disconnected from its shading group it will 
continue to be drawn in shaded mode but will not appear when 
rendering. This is different from polygon objects which will not 
appear in shaded mode in this situation.

Double transformation when objects parented with history

When an object is parented with its construction history the output 
surface may get a double transformation when the group is moved.

Workaround

To fix this toggle the inhertsTransform flag (on the surface) to off. This 
stops the surface from inheriting the group’s transformation and fixes 
the problem. Note: the group command automatically detects and 
toggles this flag in these situations but the parent command does not.

Revolved surface limitation 

If a revolved surface is grouped with its input curve then 
transforming the resulting group will change the shape of the 
revolved surface since the revolve node’s pivot will not be 
transformed.

Workaround

This can be avoided by not grouping the curve with the surface or by 
creating a locator under the group and connecting its position to the 
revolve node’s pivot.

Transform with multiple surfaces

If a transform has multiple surfaces under it the shape node may have 
to be selected in the outliner for commands like makeLive to work 
properly.

Cycle checking may miss a cycle

The cycle checking that happens during attribute evaluation may miss 
a cycle in which incoming connections on a DAG node form a cycle 
that includes any of the worldspace attributes on its child nodes. 

Workaround

cycleCheck NODE can be used to detect these cycles if you suspect this 
to be the case.
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Loss of shader assignment for polygonal objects

While dealing with polygonal objects, deleting dag nodes that are part 
of the history of the polygon could lead to the loss of shader 
assignment. This happens only when materials have been assigned to 
faces (as opposed to the whole object). The result would be that all the 
faces of the polygon will end up in the default shading group and 
material assignment will have to be redone.

Edit > Duplicate does not work on isoparms

Workaround

Use Edit Curves > Duplicate Surface Curves instead.

IRIX: Problems on the Web page when reporting a bug

If you are using Netscape 4.x on IRIX (the default browser), you may 
encounter a problem on the reporting a bug Web page.

Workaround: we suggest you use a more recent browser for IRIX 
(such as Mozilla or Firefox); you can copy and paste the URL from 
your copy of Netscape to another browser.  

IRIX Netscape limitation

IRIX: Maya will attempt to execute another copy of Netscape if you 
are running a version of that is not found in your Unix $PATH 
environment variable. Use the Unix shell command “which netscape” 
to determine if the Netscape you are running is in your $PATH. See 
your Unix System Administrator for more information on Unix shells, 
commands and environment variables.

IRIX: Maya causes the Xsgi process to use a lot of memory

IRIX: Maya causes the Xsgi process to use large amounts of memory. 
This is not an indication of leaking memory but rather a reflection of 
the amount of user interface components created in the application. 
This is most noticeable when numerous Maya windows are opened or 
if you continuously create and destroy custom windows. 

Maya does not read previous version’s windowPrefs.mel 

Maya will not read the previous version’s windowPrefs.mel file as the 
window sizes have changed for some of the windows. If Maya 
recognized the old preferences, it could hide new functionality. 

Referencing or importing a file from the command line whose 
name is not a legal identifier

You cannot reference or import a file from the command line whose 
name is not a legal identifier unless you explicitly use the -rpr or -ns 
flags. This includes files whose file name begins with a number. 
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Workaround

• Use the -rpr or -ns flags to explicitly specify a valid renaming 
prefix.

• Rename the file to something starting with a letter (for example, 
a107953.sph.ma).

Grid -style warning from uiConfiguration script

It is safe to ignore the warning message when the -style flag is used 
for loading old Maya scene files. The warning message is a result of 
improving the functionality of the grid command. As a result the -st/
style flag is obsolete. Saving and loading Maya 4.0 or later files will 
not generate this warning message. 

UV values with no history may not be retrieved properly when 
file referencing

Tweaked UV values on polygonal geometry with no history may not 
retrieve properly in cases where that geometry comes from a 
referenced file. 

Workaround

Introduce some minimal and benign construction history on the object 
in its referenced file. For example, open the referenced file in Maya 
and perform a Move Component with construction history enabled on 
a vertex, without actually moving the vertex.

Windows 2000 problem with mapping project directories

On Windows 2000, there are problems if you create a mapped drive 
that you want to use as a project directory, and the destination of the 
mapped drive is the root of another. For example, your “scenes” 
directory of a project hierarchy is in X:\scenes or 
\\machineName\Share\scene and you map it to a local drive later, 
you will get errors when trying to open files from this mapped drive. 

Workaround

Move the all the files in the “project” (that is all the files and 
directories at the same levels as the scenes directory) down one level. 
For example, make a directory called “project” and move all the files 
into it.

Translator limitations 
The following limitations and workarounds relate to translator capabilities 
of Maya.
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MayaToAlias and StudioImport limitations

(MayaToAlias) Triangulate faces with holes 

If you want to export a Maya mesh to a wire file and this mesh 
contains a face which has hole(s) in it, you need to triangulate this face 
first.

(StudioImport) DOF camera settings are different in Maya after 
translation

DOF camera settings are different in Maya after translation.

(studioImport) Light with colored texture textures fog within 
Maya

When Maya renders (or raytraces) light fog on a light with a colored 
texture channel, the fog receives that texture, whereas in Studio it 
does not. Importing Studio files with lights that have colored texture 
channels can cause confusing results because the default sampling 
rate is 1. Try using 20 to 30 samples. 

(StudioImport) Ortho cameras not translating correctly

Ortho Cameras are not fully supported in StudioImport. 

Workaround

Change Include cameras to false for import. Or adjust the translation 
of ortho cameras manually after import.

(StudioImport) No refraction jitter with StudioImport

No refraction jitter in Maya renders after import from StudioImport. 

(StudioImport) Studio linear and volume lights translating 
incorrectly to Maya

Area and Linear lights are not transferred correctly. 

(StudioImport) Environment fog translated incorrectly

Only the simplest forms of Environment fog are translated correctly. 

(StudioImport) Stitched nurbs imported into Maya lose light 
linking

Working with shells from Studio can cause problems with light 
linking and rendering. 

Workaround

Unstitch in Studio before importing wire file into Maya.
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(StudioImport) StudioTools aim constraints have different axes 

In StudioTools, if the aim constraints on one object have different 
axes, when they come into Maya, they will share the same axis—the 
one used by the first aim constraint on your object.

(StudioImport) StudioTools faces become trimmed surfaces 

StudioTools faces become trimmed surfaces when brought into Maya. 
Sometimes, the trimmed surface may look different than the original 
face.

(StudioImport) srand (seed) replaced by rand (seed) when 
translated into Maya 

If you use function srand(seed) in your expression, it will be replaced 
by rand(seed) when the expression is translated to Maya.

Workaround

Please replace “rand(seed)” with “rand(1)” if you want a random 
number from 0 to 1. If you do want to change the seed of the random 
number in the expression, please use the “seed” function which is 
available in Maya.

(StudioImport) Texture mapped onto color in StudioTools 
becomes image planes on all renderable cameras

The texture mapped onto the color of the StudioTools environment 
becomes image planes on all the renderable cameras. The size of this 
image plane is not necessarily correct. 

Workaround

Adjust its size to get the desired result.

(StudioImport) Light glow transfer not perfect between 
StudioTools and Maya

The transfer of light glow is not perfect between StudioTools and 
Maya. The two main components are the light intensity and light 
decay. If your StudioTools light intensity is 1.0 and light decay is 0, 
then you do not need to be concerned.

Workaround

To get a perfect match between StudioTools and Maya light glows, 
just adjust your Maya glow intensity to:

glow_intensity = original_glow_intensity * 

light_intensity / decay

where decay is:

• 1 if no decay

• light_decay if decay is 1
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• light_decay**2 if decay is 2

• light_decay**3 if decay is 3

(StudioImport) Layered shader created in Maya for layered 
StudioTools shaders

If several shaders in StudioTools are layered on an object, a layered 
shader is created explicitly in Maya for these shaders.

(StudioImport) StudioTools image plane placement

For StudioTools image plane placement to correctly convert, set the 
Persp window in StudioTools to the same resolution as the default 
render resolution, and also choose Screen as the image space type.

(StudioImport) Backdrop image and texture on background 
color in StudioTools conversion limitation 

Both the backdrop image and the texture on the background color in 
the StudioTools environment are converted to image planes on the 
renderable cameras. The depth of the image plane for the backdrop 
image is set to 90% of the far clipping plane. The depth of the image 
plane for the background color texture is set to 95% of the far clipping 
plane.

(StudioImport) Losing animation sequence number during 
conversion

The animation sequence number appended to the end of the image 
filename in StudioTools could be lost in Maya during the translation.

(StudioImport) StudioTools start/end mode in render globals 
conversion limitation

The start/end mode in the render globals does not translate properly 
into Maya, as Maya has no such mode. In this mode, the start and end 
frames, when transferred to Maya, may end up very different from 
the range in StudioTools.

Obj limitations

The following limitations and workarounds relate to Obj.

.obj suffix on obj filename necessary

You need a “.obj” suffix on the filename for Maya to recognize it as an 
obj file.

Workaround

Append .obj to the end of the filename.
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MTL textures

MTL textures only work with file textures.

DWG DXF limitations

The following limitations and workarounds relate to DWG DXF issues.

DXF / DWG can’t export subdivision surfaces

DXF/DWG will not export subdivision surfaces. 

Workaround

Convert to polygons prior to export. (Modify > Convert > Subdiv to 
Polygon)

OpenFlight limitations

The following known issues relate to OpenFlight:

• OpenFlight geometry will only accept textures assigned to the color 
channel. 

• Light Sources cannot be exported. Currently a single ambient light is 
always exported.

• An attempt is made to map Eye Points to Cameras in Maya; however, 
the mapping appears incorrect in some cases. Eye points are not 
exported from Maya.

• Track Planes are not supported.

• The only way to freeze a DOFs co-ordinates from within Maya is to 
export the scene as an OpenFlight file and then read it back in.

• Articulations on group nodes are not supported.

• Maya’s LODs need to be extended to better handle the flexibility of 
the OpenFlight LODs.

• If you perform a Freeze Transformations on a translated Light Point, 
Maya versions older than 4.0.3 will crash. This can be fixed by 
updating to Maya 4.0.3 or higher.

• File textures may only be applied to the color attribute of a Maya 
shader. Textures applied to other attributes are ignored.

• Normals on faces are ignored on import. Maya regenerates the 
normals based on the vertex ordering. However edge settings are 
preserved.
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IGES import and export

Level Mapping is not working on export

When using IGES export, level mapping (layers) is not supported. 

Additional transform nodes are created for trimmed surfaces

When using IGES export, trimmed surfaces can be exported with extra 
transform nodes. 

Non-planar planes not imported

Some systems, namely CATIA V5, write out non-planar plane entities. 
This is not currently supported by our IGES import. 

Miscellaneous translators

Compression not working using VRML2, OpenInventor export

To use compress in Export Vrml2 and Export OpenInventor please 
ensure that a zip utility such as gzip is installed and in the path on 
your machine.

Platform-specific limitations

Maya for Windows limitations

The following limitations and workarounds relate to Maya for Windows 
issues.

(Windows) Deleting menu items from tear-off menu on Maya

Deleting a menu item from a menu that has been torn off will cause 
Maya (for Windows) to crash. 

Maya for Linux limitations

The following limitations and workarounds relate to Maya for Linux 
issues.

(Linux) getModifiers command doesn’t seem to work on Linux

Maya for Linux may not recognize the Ctrl+click key/mouse 
sequence. 

(Linux) Linux and GNOME and mouse pointer as black “X”

Sometimes when you right-click and the mouse pointer becomes a 
black “X” it remains so for the Maya session and even after restarting 
Maya. 
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Workaround 

Set the environment variable MAYA_MMSET_DEFAULT_XCURSOR; the 
value does not matter. If this variable is set, Maya will set the cursor 
to the left pointing arrow Cursor on exiting the Marking Menu/
Hotbox. 

When exiting the hotbox with the workaround already in place, the 
cursor may remain as the right-pointing red arrow. To remedy this, 
right-click the scene after exiting the hotbox. The cursor becomes the 
default left-pointing black arrow. However, the red arrow won’t show 
up again when you enter the hotbox until you log out and log in 
again.

(Linux) Linux and GNOME and Marking Menu/Hotbox

When using GNOME window manager on Linux, on exiting from the 
Marking Menu/Hotbox the cursor may be reset to the default desktop 
"X" cursor. 

Workaround 

Set the environment variable MAYA_MMSET_DEFAULT_XCURSOR; the 
value does not matter. If this variable is set, Maya will set the cursor 
to the left pointing arrow Cursor on exiting the Marking Menu/
Hotbox.

When exiting the hotbox with the workaround already in place, the 
cursor may remain as the right-pointing red arrow. To remedy this, 
right-click the scene after exiting the hotbox. The cursor becomes the 
default left-pointing black arrow. However, the red arrow won’t show 
up again when you enter the hotbox until you log out and log in 
again.

(Linux) Display differences—with/without hardware overlays

What is displayed as red with hardware overlays is displayed as gray 
and black on cards without hardware overlays.

If there are no hardware overlays, plug-ins written assuming overlays 
will probably not work as expected.

(Linux) Dragging and dropping

Dragging and dropping from the desktop to Maya may not work.

(Linux) Window sizes

Some windows may have no height or width initially. Also, a 
window’s default size may prevent option menus from being visible 
and readable.
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Workaround

This usually occurs the first time the window is opened when its size 
has not been previously set. Resize the window manually. 

(Linux) Setting color resources

You have to set color resources manually since the SGI color schemes 
are not available to help set colors. 

Workaround

You can use the file MayaScheme to customize the resources used. 
Copy the file from /usr/aw/maya/app-defaults to 
$HOME/app-defaults.

(Linux) Interface Preferences settings for Show Title Bar in 
Main Window and In Script Editor

(Window > Settings/Preferences > Preferences > Interface) The states 
of these window’s title bars are not affected by the settings in the 
Interface: General Interface Preferences window.

(Linux) Changing system font display settings

You cannot edit the font display in Maya Linux using the system font 
settings.

Workaround

You can edit the MayaScheme file in /usr/aw/maya/app-defaults/ 
to modify the additional X resources used by Maya to change the 
system font display settings. This file is searched in the following 
location order:

$HOME/app-defaults/MayaScheme

/usr/lib/X11/app-defaults/MayaScheme

$MAYA_LOCATION/app-defaults/MayaScheme

To list available fonts, use the xlsfonts command. Alternatively, you 
can use the xfontsel command to generate a font string.

See also “Using the MayaScheme file to set fonts, font sizes, and 
colors” in the Linux chapter of the Installation and Licensing guide.

Note You must have root permission to edit the MayaScheme file 
when it is located in the /usr/lib/X11 or $MAYA_LOCATION 
directory. 
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(Linux) Maya windows disappear

Depending on the window behavior defined in the Window Manager 
control panel, windows may automatically raise (come to the front) on 
focus or when clicking in them. This may result in Maya child 
windows to disappear. They have been pushed down, and the new 
window is brought forward.

Workaround

Change the default settings for the following:

• For KDE, and Gnome/Metacity, see”Additional Linux Notes” in the 
Installation and Licensing guide.

(Linux) Putting menu items or option windows on the shelf

When you post a menu in Maya, then press Shift-Ctrl-Alt and click a 
menu item or option window to put it on the shelf, nothing happens.

Workaround

Use the Shift-Alt right mouse button instead. 

(Linux) Maya for Linux does not support creation of movie files

Maya Linux does not support creation of movie files. This prevents 
certain other functions, such as Playblast, from working. This also 
means that Maya Live pointblasts cannot output in movie format. 

Playblast can still output a series of images and play it back using 
FCheck.

(Linux) Menu items do not seem to be selected

If you click an extended tab panel to show the pop-up menu on a tab 
panel (as in the Attribute Editor), the cursor appears just inside the left 
edge of the menu but no menu items are highlighted. The item 
beneath the cursor is actually selected, but it is not highlighted.

Workaround

Move the cursor slightly to the left to deselect the menu, then go back 
to the menu and select a menu item.

(Linux) Option sub-menus not always visible

Sometimes file placement dialog boxes do not display option sub-
menus in a readable or visible form. 

Workaround

Try manually resizing the dialog boxes so the option sub-menu is 
completely visible.
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(Linux) Blank Getting Root Frames progress window

When you solve in Maya Live with the Gnome window manager, the 
first Getting Root Frames progress window goes blank and stays in 
the screen as long as Maya is running. This blank window is present 
in all applications. 

Workaround

After the solve is complete, save the scene and restart Maya to remove 
the blanked out portion of the screen. Alternatively, you could use a 
different window manager than Gnome. 

(Linux) Input connections do not appear in Hypershade

In Hypershade, when you connect a node1 output to a node2 input, 
the full menu list of input connections does not appear when you click 
the node2 input arrow. 

Workaround

Click the node2 image itself instead of the input arrow. The full 
selection is then listed.

Maya for Mac OS X limitations

The following limitations and workarounds relate to Maya for Mac OS X 
issues.

(Mac OS X) Dynamic unloading of plug-ins disabled

We have disabled the unloading of plug-ins during a Maya session. 
Our current implementation of plug-ins on Mac OS X uses dylibs. This 
type of library has issues with releasing library data correctly during 
unload. As a result, the load/unload/reload sequence can cause Maya 
to crash if old data is left around. A warning appears in the Script 
editor if you attempt to unload a plug-in.

To run Maya without a particular plug-in loaded, open the Plug-in 
Manager window, turn off Auto load, and restart Maya. 

(Mac OS X) Hotkeys conflict with Exposé

Exposé hotkeys (F9, F10, F11) may conflict with preset Maya hotkeys. 
If you experience this problem, you can change the Maya hotkeys, or 
change the Exposé hotkeys in the System Preferences panel of the 
computer running Mac OS X.

(Mac OS X) Performance limitations

Maya for the Mac OS X may become slower or less stable after a 
period of time. 
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Workaround

For best performance, we recommend you save your work and restart 
Maya every few hours.

(Mac OS X) Mac OS X file fails to open on Windows XP when 
transferred the wrong way

The only reliable way to transfer Maya ASCII files between Macintosh 
computers and other platforms running Maya is to use ftp in ASCII 
mode. 

(Mac OS X) Maya starts up with library errors or stops at the 
Script Editor

The solution is to rename your hard drive on which Maya is installed. 
There is a problem with double byte characters being passed to Maya 
and therefore the name of your hard drive must not contain any 
special characters. Also, try and stick to the Roman alphabet. Spaces 
do not seem to be a problem, but it is best to avoid them. Simply use 
an underscore in place of a space. 

(Mac OS X) Default location to install plug-ins

Maya for Mac on OS X provides a default location where you can 
install plug-ins:

/Users/Shared/Alias/maya/6.5/

See also “Load or unload plug-ins” in the Basics guide.

(Mac OS X) Feature differences between Mac OS X and 
Windows

The following features differ between Mac OS X and Windows 
versions of Maya.

Features for Windows not available for Mac OS X

• Ability to read in pre-Maya 3.0 files

Features for Mac OS X not available for Windows

• Tear-off menus in Hot Box

• Posting menus in Hot Box

• QuickTime integration

• Threaded sound playback in time line during scrubbing

• AppleScript executes Maya MEL commands with results 
returned. (See also “Communicating between Maya and Mac OS X” 
in the Release Notes and “Calling MEL from AppleScript and vice-
versa” in the MEL and Expressions guide.)
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3rd party programs not available for Mac OS X

• Invigorator Maya plug-in (the standalone program is available).

• Motion capture drivers

(Mac OS X) Device Editor removed from Maya

Window > Animation Editors > Device Editor has been removed from 
the Maya user interface. Maya only supports the mouse and tablet.

(Mac OS X) Command Shell removed from Maya

Window > General Editors > Command Shell has been removed from 
the Maya user interface. No alternative to the Command Shell exists 
in Maya for Mac OS X. 

(Mac OS X) FCheck limitations

The following options are not available for this release: offset, bump, 
color, negate, tocin, fromcin.

The FCheck info window numbers the frames using 1 for the start 
frame you indicate, which may not be the same as the numeric part of 
the filename. For example, if you choose frame 4 of an animation to be 
the start frame in the FCheck window, the FCheck info window 
identifies it as frame 1 of 7.

(Mac OS X) Transferring files between platforms

Mac OS X files use different line endings than UNIX or Windows files. 
Mac OS X programs accommodate this by accepting any line ending, 
but Windows and UNIX programs require only their own form of line 
ending—including the UNIX-like programs run from the Mac OS X 
Terminal window. 

Two UNIX utilities, which you run from the Terminal window, are 
included in the Maya bin folder to help you easily transfer files from 
one platform to another: tounix and tomac. 

The following table describes what you need to do to transfer files 
between specific platforms.

From To Requires

mayaBinary on OS X Any platform Put as a binary file using ftp from the Terminal 
window, the Fetch application in binary mode, 
or any other Mac OS binary mechanism; or
Use AppleShare IP on the non-Macintosh 
platform to transfer as a binary file from the 
Mac OS. (Using ftp from the non-Macintosh 
platform corrupts the file.)
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(Mac OS X) Maya can’t read files with special characters in 

mayaBinary on UNIX 
or Windows

Maya Get as a binary file using ftp from the Terminal 
window, the Fetch application in binary mode, 
or any other binary mechanism; or
Use AppleShare IP on the nonMacintosh 
platform to transfer as a binary file from the 
Mac OS. (Using ftp from the nonMacintosh 
platform corrupts the file.)

mayaAscii or mel files 
on UNIX or Windows

Maya No special handling

Maya mayaAscii or 
mel files

Maya 5.0+ on UNIX 
or Windows

No special handling

Maya mayaAscii or 
mel files

Mac OS X 
applications that 
read text files

No special handling

Maya mayaAscii or 
mel files

Mac OS X UNIX 
applications (for 
example, vi or grep)

Use the tounix utility. From the Terminal 
window, enter:

tounix scene_file.ma

Maya mayaAscii or 
mel files

Maya 3.0 on UNIX or 
Windows

a) From the Terminal window, use the tounix 
utility: tounix scene_file.ma

then ftp as an ascii file.

or

b) Use the interactive Macintosh application 
Fetch, in ascii transfer mode.

mayaAscii or mel files 
that have been run 
through tounix utility

Mac OS X 
applications that 
read text files

Use the tomac utility. From the Terminal 
window, enter:

tomac scene_file.ma

mayaAscii or mel files 
that have been run 
through tomac utility

Maya No special handling

mayaAscii or mel files 
that have been run 
through tounix utility

Maya No special handling

From To Requires
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pathnames 

Maya cannot read files from folders whose name includes a trademark 
symbol.

Workaround

Move the file out of the folder or delete the symbol from the folder 
name.

(Mac OS X) Special characters in pathname kill Maya on 
startup 

Maya fails to launch if there are special characters in the full 
pathname that points to your Home folder. (Spaces and colons do 
work.)

Workaround

Starting from the diskname, make sure the path to your Home folder 
does not include special characters.

(Mac OS X) Problem with floating license servers

As of OS 10.2, Maya licenses require a hostname other than 
"localhost". 

Workaround

If you have floating license servers, you may need to modify the 
"<Hostname>" field of the "SERVER" line(s) in both Server and Client 
License Files to reflect this change: 

SERVER <Hostname> <HostID> <Port#> 

The value for "<Hostname>" can be determined by opening a 
Terminal window and typing "hostname -s" on the command line. 

(Mac OS X) AW_JPEG_Q_FACTOR env variable does not 
function as expected

You can not change the value of the AW_JPEG_Q_FACTOR 
environment variable. Maya always renders at the default value (75).

(Mac OS X) High resolution display limitation

Large size images (typically greater than 1280x1024) do not get 
displayed properly in the scene views and editors when these are 
used as image planes or textures. They will render correctly.

(Mac OS X) Can't use a back slash code in MEL (Korean and 
Japanese systems only)

Workaround 

Type the string on the same line (do not use a back slash to carry the 
string to the next line).
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(Mac OS X) Texture placement manipulator disappears

The Texture Placement manipulator disappears when you make 
placement changes.

Workaround

Click with the middle mouse button anywhere in the empty space of 
the scene view to get back the manipulator 

(Mac OS X) Interacting with Speed buttons in Fcheck has no 
effect

In Fcheck, when Every Frame is on, interacting with the Speed 
buttons (-, +) has no effect on the playback speed.

(Mac OS X) Folders in the project folder beginning with a bullet 
character cause Maya not to start

If you have a folder in your /Users/username/Documents/maya/
projects folder that has a bullet character (option 8) in its name, 
Maya will not retain the project as it is set. It will return to the default 
the next time Maya is run.

Workaround

Remove the problem folder or rename it and restart Maya.

(Mac OS X) Cannot render interactively with resolution of 4K or 
higher

You cannot render interactively in the Render View if the resolution is 
set to 4K or higher. 

Also, if you render an image successfully and then render it again 
with a lower resolution, the rendered image does not reduce in size. 

(Mac OS X) Fonts are the same for all attributes in Hypershade 
connection menu

When you middle-drag a node in Hypershade to connect it to another 
node, the connection menu displays all the attributes in the same font 
so you do not know which ones are already connected. Connected 
attributes should be in italics.

(Mac OS X) Hardware Render Panel does not open

The Hardware Render Buffer does not open in a panel. If you add the 
Hardware Render panel to the Panels menu (in the Panel Editor, click 
the Edit Layouts tab, click the Contents tab, and select Hardware 
Render Panel from the Select Panel by Type menu), the panel is blank 
when you select it.
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Workaround

Use the Hardware Render Buffer in a separate window, instead of 
using it in a panel. (Select Window > Rendering Editors > Hardware 
Render Buffer to open the Hardware Render Buffer in a separate 
window.)

(Mac OS X) Display problem when selecting isoparm of 
NURBS surface

A strange pattern may display when you select an isoparm of a 
NURBS surface.

Workaround

Select the isoparm again to remove the pattern.

(Mac OS X) Tabbing doesn’t always work as expected in Add 
Attribute window

Tabbing in the Add Attribute window (in the Attribute Editor, select 
Attributes > Add Attributes), does not always work as expected.

(Mac OS X) 2D textures on volumetric objects

When using 2D textures on volumetric objects, they must be used as 
projections.

(Mac OS X) Turning on Emit Ambient volume light attribute 
does not update the IPR render

Turning on Emit Ambient in the volume light Attribute Editor does 
not update the IPR render.

Workaround

If you change the status of Emit Ambient, you have to modify another 
attribute of the volume light to get the ambient light to update 
correctly in IPR. From that point on, the ambient component of the 
volume light will display correctly in IPR.

(Mac OS X) You must press the set focus hotkey (Alt ‘) twice to 
change the focus

If "Alt `" is used as the hotkey to set focus to the numeric input field, 
then it must be pressed twice to set the focus to the numeric input 
field. However, if another hotkey is used (instead of "Alt `") to 
accomplish the same functionality, then pressing the hotkey 
combination once is sufficient.
Maya 6.5 Release Notes

134



18 Maya commands
Release 
notes

Maya commands limitations

Menu bar layouts

Menu bar layouts are not visible until a child control is added.

Workaround

Create the menu bar layout and children and then show the window. 

Using a string as an integer may crash Maya

Maya may crash if you source a MEL script that tries to operate on a 
string as an integer. 

MEL array limitation

When a MEL array is specified using the {} notation then the type of 
the array is inferred from the first argument in the array. Therefore, an 
array declared with an integer as its first argument will generate a 
warning if a float value is specified later. These values will be 
converted to integers. Here is an example:

float $arr[] = { 1, 2.5 };

// Warning: Casting from float to int may result in 

a loss of precision. //

print($arr[0] + “ “ + $arr[1] + “\n”);

1 2

The value of the second element in $arr is 2, not 2.5 as expected.

Workaround

Make sure you declare the first element of the array as the type that 
you want the array to have. In the case above, this would mean 
declaring the array as: 

float $arr[] = { 1.0, 2.5 }; 

By declaring the "1" as "1.0", the type of the 

array is indicated to be float. 
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Locally scoped procedure definitions cannot be forwarded

MEL does not allow you to forward reference locally scoped 
procedures. 

Workaround

Locally scoped procedure definitions must appear before they are 
called. For example, in a file called noForwardRef.mel, define the local 
procedures before they are referenced.

proc myLocalProc() {
    print “In myLocalProc()\n” ;
}
proc anotherLocalProc() {
    print “In anotherLocalProc()\n” ;
    myLocalProc;
}
global proc noForwardRef() {
    print “Calling anotherLocalProc()\n” ;
    anotherLocalProc;
}

Scripts with infinite loops

If you write a script that has an infinite loop in it (usually within a 
while statement), there is no way to interrupt it without stopping 
Maya from the Task Manager on Windows or from the UNIX shell on 
IRIX (kill -2).

Workaround

Before writing scripts make sure you save any data you were working 
on.

Assigning string attributes to strings limitation

MEL does not support assigning string attributes to strings in 
statements like: 

string $str = foo.str

Workaround

Use this instead:

string $str = ‘getAttr foo.str‘; 

Splitting strings tip

In MEL scripts, do not split strings across lines without using a line 
continuation character ‘\’. 

For example:

button -label “Make 
a sphere”;
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is incorrect. However,

button -label “Make \
a sphere”;

is correct.

Sourcing MEL scripts with unterminated C-style comment

Sourcing a MEL script that has an unterminated C-style comment (/* 
comment */) will cause Maya to go into an infinite loop and must be 
killed by the operating system.

Workaround

Use C++-style comments (// comment) instead of C-style comments 
or ensure that  all of your C-style comments are properly terminated 
by the closing "*/". 
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File formats limitations

(Mac OS X) Supported file formats

In Maya, you can render to all QuickTime file formats. This does not 
include GIF, which is supported on IRIX and Windows. 

You can import the following file types:

mayaAscii and mayaBinary file formats preserve information

The mayaAscii and mayaBinary file formats are the only ones that 
preserve all the information contained within your scene. Setting the 
output format for an export using the Export Options box will change 
your default export format for the current and subsequent export 
operations. If you set the output format to something other then 
mayaAscii or mayaBinary and export using that format and then quit 
without saving the entire file then you can lose data.

Workaround

Always check the export type in the export file browser to ensure you 
are writing the file using the expected file format.

Wait cursor may display after loading files

After loading a file, a wait cursor may come up and Maya will use all 
available CPU cycles for a long time (several minutes at least). This 
problem seems to occur in files that have IK and dependency loops. 

Workaround

The ideal workaround is to find and remove the dependency loop. 
These loops may be difficult to find. For example, A may be translated 
by a pointConstraint B that uses target C that has a parent D that is 

Maya MEL (.mel) OBJ (*.obj)
Maya ASCII (*.ma) audio (*.wav, *.aiff, *.mp3, *.snd2, *.au)
Maya binary (*.mb)

image (all QuickTime formats)

EPS (*.*)

ILL (*.*)

MOV (*.*)

Note Many other file types are now available by using translators 
with Maya (DWG, IGES, Studio wire files, etc.). Please see 
the Maya Help for full details.
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rotated by an expression E that has an input from F that is constrained 
to G which is a child of A. One hint is to look for expressions that 
have outputs to attributes on many different nodes.

Sets on .obj files imported into Maya considered shading 
groups

All sets on .obj files imported into Maya are considered shading 
groups. This means that adjustment of an object’s rendering groups 
within Maya causes simultaneous modification of the membership of 
the sets that were imported from the .obj file. 

Workaround

In Maya, for each .obj file set whose membership you wish to 
preserve, select the contents of the set and create a new set. 

Export selection and sets limitation

When using export selection, any sets that contain the selected objects 
will not be exported.

Workaround

To preserve any sets that contain the selected objects, you must also 
manually add the corresponding set nodes to the selection list.

For example, to export two spheres (named nurbsSphere1 and 
nurbSphere2) contained in a set named set1, use the “select -ne” 
command to add set1 to the selection list before exporting:

    select nurbsSphere1 nurbsSphere2;
    select -tgl -ne set1;

Error when saving and exporting files

If a file is saved and then a file with the same name is exported using 
a different type, attempting to open the exported file will result in an 
error.

Workaround

Manually set the type of the file to be read in or do a File > New Scene 
first.

Changing project options using the workspace command

When you change any project options using the workspace command, 
you must use the -s flag before the changes will be saved. Background 
processes, such as the Batch Renderer, use the saved values when 
searching for or saving files. If you do not use the -s flag, Maya will 
display the following error message when you render:

//Warning: Image file cannot be output.Check the file 
permissions//
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Maya can crash when unloading plug-ins

Maya can crash if a plug-in is unloaded and a script that calls that 
plug-in is executed.

Workaround

Do not unload plug-ins unless you are sure that they are not longer 
used by Maya.

File commands saved from the menu bar

File commands saved from the menu bar to the shelf do not save all of 
their settings from the option windows. 

Workaround

Type the complete command in the script window and drag it to the 
shelf.

File names with quotation marks cause problems

Maya will generally have problems with file names that have 
quotation mark characters in their names. For example: 
TheQuoted”Word”.ma. 

Workaround

Rename the file with single quotes or some other character in place of 
the double quotes. For example: TheQuoted’Word’.ma.

Importing Adobe Illustrator 9.0 eps files into Maya

Importing an Adobe illustrator 9.0 eps file into Maya results in a 
transform node, but there is nothing in the view. 

Workaround

In Adobe illustrator 9.0, save as an eps file and specify that it be in 
Adobe Illustrator 8.0 format.

File referencing limitations

File referencing architecture updates for Maya 6.5

Due to architectural changes that were made to file referencing in 
Maya 6.5 the file format used to represent the referencing information 
has changed drastically. We have gone to great lengths to ensure that 
there will be no backwards compatibility issues when opening an 
older Maya file containing references in Maya 6.5. If any issues are 
still encountered, the following workaround may assist in resolving 
backwards compatibility issues.
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Workaround

Open the file in Maya 6.0, unload all the file references, save, and then 
re-open the file in Maya 6.5. 

Proxy references do not support renaming prefixes in Maya 6.5

Renaming prefixes do not work with proxy references for name clash 
resolution.

Workaround

Use the namespace option when working with proxy references.

Users must manually check for unique names when renaming 
proxy tags in Maya 6.5

Additional work is required to rename proxy tags within Maya.

Workaround

Each proxy in a proxy set must have a unique tag in order for the 
proxy to work properly. While the Attribute Editor allows you to 
change the tag, it doesn’t check that the new name is unique. The 
following steps describe how to find and assign a unique name for a 
proxy tag. 

1 Identify your proxy manager's name from the Reference Editor. For 
example, myPM. 

2 Get a list of the reference nodes in the proxy set: 

string $refNodes[] = `listConnections -type reference 
myPM.proxyList`; 

3 Create an array of all the tags in those reference nodes 

int $refIndex = size($refNodes); 

string $tags[]; 

while( $refIndex-- > 0 ){ 

  $tags[$refIndex] = `getAttr ($refNodes[$refIndex] +
  ".proxyTag")`; 

} 

4 Manually rename the desired tag making sure that the new name is 
not one of the elements of $tags. You can do this in the Attribute 
Editor or by typing the following:

setAttr -type "string" myRN.proxyTag "myNewUniqueTag";

Referencing multiple scenes that contain mental ray data 
produces unexpected results

Referencing multiple scenes that contain mental ray for Maya data 
may cause the following issues:
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• The Script Editor displays multiple warning messages regarding 
already connected nodes when the referenced files are loaded.

• Rendering the scene produces an image based on unexpected 
render global settings.

Maya does not correctly distinguish between the shared nodes that 
exist for mental ray Render Global Settings. Each time a reference 
within one of these nodes is loaded, it applies the setAttrs and 
connectAttrs from that file to the shared node. The mental ray for 
Maya Render Global Settings that result will depend on the last 
reference that gets loaded.

Workaround

• In Maya, set the same Render Global Settings for each file you 
intend to reference for your scene.

• Reference the files into your parent scene, ignoring the warning 
messages.

• Confirm the mental ray for Maya Render Global Settings prior to 
rendering.

Instancing referenced objects or referencing instanced objects 
may cause shading network disconnection on subsequent 
loading of the reference

Shading network connections may become broken when loading and 
unloading instanced references or when saving reference edits from 
an object when the object has been instanced.

Workaround

Reference the scene multiple times or copy the reference instead of 
instancing it. You can also create a script that reassigns your materials 
automatically. . 

Optimize Scene Size limitation with file referencing

If you optimize a parent scene file containing file references that are 
unloaded, data loss may result, especially if nodes from the referenced 
files have been parented or grouped individually, or had shaders and 
materials that were only used for referenced objects

Workaround

If you want to optimize a scene containing file references, optimize 
the individual referenced files first, then optimize the parent file with 
the references loaded. 

When a reference is locked, animation on compound attributes, 
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such as translate and rotate, may not play back.

Workaround 

If you need the animation for feedback, but want to make sure that 
the reference is not accidentally modified, you can customize your 
locking by adding the parent compound attributes to the Excluded 
attibutes script. Alternatively,  instead of locking the reference, you 
can put it in a display layer with the appropriate settings to avoid 
accidentaly selection.  

Export As Reference not working with file references 
containing multiple layers

It is not possible to Export As Reference multiple objects from a scene 
where multiple layers exist.

Workaround

Remove the multiple layers and export the objects as references and 
reassign the layers afterwards.

Poly mesh geometry must have construction history to be 
modified within the parent scene

If you reference a scene containing a poly mesh and perform 
modifications to that mesh from within the parent scene, those 
modifications will not be respected unless the poly mesh had an 
existing construction history before it was referenced.

Workaround

Ensure that any referenced poly mesh geometry has at least one 
history node in the referenced file prior to referencing..

Scenes where an existing file reference contains animation and 
deformers and additional animation gets added to the 
reference in the parent scene may not evaluate completely 
when a reference is first loaded

In some situations when referencing a file with deformers and 
additional animation, the scene may not evaluate completely when 
the reference is loaded. As a result objects may not animate or appear 
in an incorrect position.

Workaround

Using the dgdirty MEL command will force Maya to recalculate the 
dependency graph for the scene. Doing a dgdirty -a will set all 
plugs to be dirty. 

Reference edits may be lost when using identical node names

In order to apply an edit to a node from a reference it must be able to 
uniquely identify the node. In the following cases this is not possible:
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• Using renaming prefixes and you add a node to the parent file 
that has the same name as the renaming prefix and the reference 
node name.

• Using namespaces and you apply an edit to a node with a unique 
name and then you add more nodes with the same name to the 
referenced file. 

Workaround

Make sure the names of your nodes are unique before you start 
applying edits in the parent scene.

Hypergraph layouts of objects from referenced files ignored

The Hypergraph layouts of objects from referenced files are ignored 
when the file is referenced. 

Workaround

Make any adjustments to the layout of the objects in the referencing 
file. Keep your Hypergraph closed when importing/referencing, and 
then clean up afterwards.

Expressions and back-quoted commands limitation

If a referenced or imported file contains expressions and the 
expressions contain back-quoted commands, then the part in back-
quotes will not have any node names prefixed properly.

Workaround

Use namespaces when referencing or importing files. Alternatively, 
you can modify your expressions to not use MEL commands or back-
quoted expressions. C style expressions such as “foo.x = 0.5” are 
treated correctly in references and the nodes will be correctly 
renamed. However, MEL style commands such as “setAttr foo.x 0.5” 
will not work correctly. 

Limitations with using prefixes for name clash resolution

When referencing a file using a renaming prefix that in turn references 
a file using a namespace, the outer renaming prefix will be turned into 
a namespace instead. 

Referencing a file into the same scene multiple times using the default 
renaming prefix will result in ambiguous references to the objects 
contained within that file. Note that referencing a file multiple times 
into the same scene can happen indirectly if a file being referenced or 
imported references that scene. 

Workaround
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Use namespaces for all your file references. For import though, once 
you use namespaces, everything gets put in a namespace, whether it's 
clashing or not (even if it already has a namespace, it gets another one 
added on). But if you use prefixes, it will strip out existing 
namespaces, and then resolve clashes with prefixes. So you may wish 
to choose your method of clash resolution depending on what's in 
your file already. Alternatively, you can ensure that you assign unique 
rename prefixes to files that will be imported multiple times. You can 
do this by going to the File > Import options box or by using the -
renamingPrefix flag on the file command in the Script Editor.

Problems importing and referencing the same file with the 
same prefix

There are problems with importing and referencing the same file with 
the same prefix. If the file is referenced and then imported then all is 
well. However, if the file is imported and then referenced, there are 
ambiguities in object names. Also, if the same renaming prefix is used 
with multilevel references, the resulting file may contain errors..

Workaround

Use namespaces when importing or referencing files. Alternatively, 
you can either reference the file before importing it or change the 
renaming prefix between importing and referencing. 

Namespace or name-clash mechanisms limitation

When creating a reference in the current scene, and this reference in 
turn contains a referenced MEL script, the namespace or name-clash 
mechanisms will not be applied to any node names referred to in the 
script. This can cause problems if the MEL script relies on explicit 
names that are contained in the referenced file.

Workaround

Try to create MEL scripts that are not dependent on the actual naming 
of nodes contained in the scene. 

Can't replace nested reference 

Replacing a nested reference file (i.e., a reference which is not a child 
of the main scene) is a temporary action. The reference to the new file 
will not be saved with the main scene. 

Workaround

Open the parent file of the reference and replace it there.

Saving reference edits with instances limitation

Saving reference edits on file references that have been instanced 
within the parent scene may result in the objects not being parented 
correctly. 
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Workaround

Save any reference edits to the referenced file prior to instancing. 
Alternatively, you can remove any existing instances prior to saving 
reference edits and then re-instance the objects. You can also create a 
temporary reference to the file that you want to modify, save the edits 
on that reference, and then reload the instanced reference.

Saving reference edits with multiple parenting operations 
limitation

Saving reference edits on scenes that contain multiple parenting in or 
parenting out connections when the parent scene nodes are parented 
into the same file reference or a different file reference may result in 
the DAG hierarchy no longer being correct.  

Workaround

Save reference edits prior to doing any complex parenting operations 
or temporarily unparent the nodes. Alternatively, you can create a 
new temporary reference to the file you want to modify, save the edits 
on that reference, and then reload the reference that contains the 
multiple parenting operations.
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RIB Export limitations

The following limitations and workarounds relate to Rib Export.

Not all Maya objects are converted by RIB plug-in

Not all Maya objects are converted by the RIB plug-in. Most notably, 
textures and particles are not converted. However, cameras, lights, 
geometry and their animation are translated correctly. A very simple 
algorithm maps Maya’s lambert, phong, and blinn shaders to their 
RenderMan equivalents and copies the color attribute. If a texture is 
mapped to the shader in Maya, then the resulting RenderMan color 
will be indeterminate. Also note that this version of the plug-in does 
not support per-face shading groups, thus shaders assigned to specific 
faces will not be converted, and those faces will be white when 
rendered by RenderMan.

Maya light decays and RenderMan default settings

RenderMan’s lights all have a decay of 2, which may cause 
illumination mismatches in lighting if you have your light’s decay set 
to anything other than 2 in Maya.

Workaround

Set all Maya light decays to 2.

Maya’s ambient lights are not well represented in RenderMan

Maya’s ambient lights are not well represented in RenderMan and 
will tend to wash out the RenderMan rendered scene once translated.

Workaround

Reduce the intensity of your ambient lights before translation, remove 
them altogether, or set the ambient shade parameter to 0 in Maya to 
better match the RenderMan look.

Warnings for scene written to RIB with disabled motion blur

If a scene is written to RIB with motion blur disabled, when that file is 
rendered by RenderMan it will generate warnings of the form: 
“R07005 Premature RiMotionEnd”. 

Workaround

These can be safely ignored. This problem will be corrected in a future 
Maya release.
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API and Devkit limitations

The following lists limitations and workarounds for the APi and Devkit 
for Maya 6.5. We also recommend that you read the API guide 
documentation before attempting a major project using your Maya.

(Windows only) Maya plug-in wizard for Windows can 
sometimes create bad projects

It’s possible for the Maya plug-in wizard to successfully get a bad 
vendor string from the registry. When this happens, the bad string 
will be inserted into the generated code and can make the .cpp look 
like binary instead of text. 

Workaround

To solve this problem, enter a proper string for the vendor when 
prompted by the plug-in wizard.

Attribute changed callbacks limitation

Attribute changed callbacks are not invoked if the modification to the 
attribute is made by a tool such as Move. 

MFnDependencyNode flags limitation

MFnDependencyNode flags are not reset when they are deallocated. 
Resetting these flags requires an entire DG traversal. 

For best performance, it is better for you to control this operation since 
you may only be interested in a subset of the depend nodes in the scene. 

MFnMesh::assignUVs() does not support history

The method MFnMesh::assignUVs() does not support history. As a 
result, modifications made to UVs with this method may be 
overwritten as the dependency graph updates. 

MArgDatabase::getFlagArgument() does not work correctly

The method MArgDatabase::getFlagArgument() does not work 
correctly other than with an index of 0.  Use the 
getFlagArgumentList() method instead. 

Long names of attributes can be incorrectly re-used

It is possible to create new attributes on a node that have the same 
long name as an already existing attribute but differs by the short 
name. This will cause updating problems for the Channel Box and 
Attribute Editor.  
Maya 6.5 Release Notes

151



21 | API and Devkit
Release notes > API and Devkit limitations
MFnNurbsSurface::isFlipNorm() limitation

The method MFnNurbsSurface::isFlipNorm() can be used only on 
trimmed surfaces.

Workaround

Use the method MFnNurbsSurface::isTrimmedSurface() in your code 
to detect if the surface is trimmed before using the method. 

API plugs and dependencies hierarchy limitation

The API does not support hierarchies of plugs and their dependencies 
in a single dependency node. Dirty propagation works correctly 
across connections between nodes, but not between internal attributes 
on a user-defined node made with MPxNode. 

Workaround

Use the method attributeAffects() to “flatten hierarchies” when 
declaring their affects behavior between all inputs and outputs on 
your node.

MItMeshPolygon limitation

MItMeshPolygon::getArea does not work in World Space. The Object 
Space area is always returned.

Workaround

Use MItMeshPolygon::getTriangles to get the triangles in World 
Space; then calculate the areas of the triangles and sum them

OBJ files need “.obj” extension

Wavefront OBJ files need the .obj extension to be recognized 
automatically when the File > Open Scene Import option is set to Best 
Guess.

Workaround

Set the Import option to OBJ to import a file without the .obj 
extension.

MSyntax::makeFlagMultiUse() limitation

The method MSyntax::makeFlagMultiUse() currently has no effect.

Workaround

In a future release of Maya, related methods will be exposed on 
MSyntax which will make it possible to use the method.
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Batch rendering scenes with plug-ins

If you have a Maya scene that uses two (or more) plug-ins, both of 
which fail in their “initializePlugin” method (due to a missing license 
for example), and both plug-ins require one of the libraries 
OpenMayaUI, OpenMayaAnim or OpenMayaFX, when attempting to 
batch render the scene Maya may produce a fatal error.

Workaround

Manually add the following lines at the end of your userPrefs.mel file.

dynamicLoad OpenMayaUI
dynamicLoad OpenMayaAnim
dynamicLoad OpenMayaFX

MItSurfaceCV limitation

The NURBS surface CV iterator, MItSurfaceCV, will ignore the 
useURows argument if a non-null component argument is passed into 
either the constructor or reset methods. In this case the iteration will 
occur in the order that the CVs occur in the component.

Workaround

The useURows flag will only be used if the iteration is to occur over 
the entire surface and hence no components or a NULL component 
are specified.

MPxGeometryData.h on IRIX

When compiling with the file MPxGeometryData.h on IRIX you will 
see the following warnings:

“MPxGeometryData &MPxGeometryData::operator=(const 
MPxGeometryData&)” does not match “MPxData::operator=” 
-- virtual function override intended?
virtual MPxGeometryData& operator =( const MPxGeometryData& ) 
= 0;

Workaround

You can safely ignore these harmless warnings.

MFnMesh::getConnectedSetsAndMembers limitations 

The method MFnMesh::getConnectedSetsAndMembers will fail if the 
function set is initialized with an MObject of type kMeshData. This 
means it cannot be used in the compute function of a user-defined 
node on a input mesh attribute.

Workaround

Initialize MFnMesh with either a DAG path or the mesh shape node 
of type kMesh.
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Cannot add or remove menu items from a torn off menu

Menu items cannot be added to or removed from a menu that has 
been torn off (Maya may produce a fatal error).

Workaround

Do not add/remove items from a menu that has been torn off, or 
make sure that if menu items need to be added or removed 
dynamically, the menu cannot be torn off. To do this, set the tearoff 
flag for the menu to false. 

Linking plug-ins on IRIX

When linking plug-ins, use the compiler flag -no_transitive_link. If 
you do not, the linker will display warning messages, such as:

ld32: WARNING 85: definition of symbolName in libOpenMaya.so 
preempts that definition in libShared.so.

In addition, using -no_transitive_link greatly decreases the amount of 
time it takes to complete the link. The Makefile in the example plug-in 
directory demonstrates a method for doing this.

loadPlugin command restriction

Do not include the loadPlugin command in the same script that uses 
the contents of a user-defined command plug-in. This is because the 
MEL parser parses the entire script before executing any of it. When 
the script is parsed, the loadPlugin command will not yet have 
registered the command, therefore MEL will not be able to parse it. 

Workaround

Use one script to load the plug-in and another to use the command it 
registers. Alternatively, you can use MEL’s eval statement to wrap the 
call to the new command. This will delay MEL’s parsing of the 
command until runtime and allow the script to be parsed correctly.

Unloading and reloading plug-in

If a plug-in command is called from an expression or a MEL 
procedure, and after the expression or procedure has been parsed, the 
plug-in is unloaded (or unloaded and then reloaded), Maya may 
produce a fatal error if the expression is triggered or the procedure is 
re-executed. When MEL parses the expression or procedure, it saves a 
pointer to the doIt method of the plug-in command. The value of this 
pointer is not normally recalculated, so if the plug-in is unloaded or 
reloaded at a different location, the pointer is no longer valid. 

Similar issues will occur if MFnPlugin::registerUI() is used to register 
a command defined by a plug-in.
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Workaround

Enclose the call to the plug-in command in a MEL eval statement. This 
forces MEL to compile the statement each time the expression is 
evaluated or the procedure is run. If the plug-in has been unloaded 
this is detected and an error results. If the plug-in has been reloaded, 
the new location of the doIt method is computed during the recompile.

Auto-loading plug-ins with Maya Live

If you have two or more Maya Unlimited plug-ins marked for 
autoload and one of these is Maya Live, Maya may encounter a fatal 
error on startup if you attempt to render or launch Maya on a system 
that only has a Maya Complete license.

Workaround

Edit your prefs file .../maya/2.5/userPrefs.mel and delete the three 
lines that look like:

if ( !catch(‘loadPlugin "mayalive"‘) ) {
pluginInfo -edit -autoload true "mayalive";
}

Custom material shader plug-in with a glow intensity attribute

If a custom material shader plug-in is implemented with a glow 
intensity attribute, this attribute will be ignored by the software 
renderer unless an internal Maya material shader in the scene (e.g. 
lambert, blinn, phong) has a glowIntensity value greater than zero. 
Currently the software renderer only queries material shader nodes 
that match the internal types for a glowIntensity value that is greater 
than zero. There is no way to directly override this limitation. 

Workaround

In order to assure the rendering of a custom shader's glowIntensity 
attribute an MSceneMessage::kBeforeSoftwareRender callback and an 
MSceneMessge::kAfterSoftwareRender callback must be registered. 
The first callback must create an internal material shader node via 
“shadingNode -asShader lambert;” and it must retrieve the node 
name returned. Then it must set that node's glowIntensity attribute to 
a value greater than zero. The second callback will simply remove this 
“dummy” node.

Connecting the plugs of two nodes and breaking the 
connection

There may be situations in which it is desirable to connect the plugs of 
two nodes and then soon after break this connection. If 
MDGModifier::connect() is used to connect geometry data between 
two nodes and if this connection is broken before the screen is 
refreshed the data will not be cached on the downstream node. 
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Workaround

A call to

M3dView::active3dView().refresh();

before disconnecting the plugs will force the dependency graph to 
evaluate. This will cause the downstream geometry node to read the 
input data, and after this evaluation the data is available for caching to 
the node if the connection is subsequently broken. 

Incomplete MPlugs

The plug passed to the user defined method that is registered with 
MNodeMessage::addAttributeAddedOrRemovedCallback() is an 
incomplete MPlug. Complex data type values will not be accessible 
via MPlug::getValue(MObject value.) 

Workaround

This problem can be circumvented by using code similar to the 
following.

MFnDependencyNode fnDn(plug.node()); 
/*where "plug" is the name of the plug passed in as a 
parameter */
MString newPlugName(plug.name()); 
/* MPlug::name() will actually return a string containing the 
"nodeName.attributeName"  so it may need to be parsed for 
the following call. */
MPlug realPlug = fnDn.findPlug(newPlugName);

In the above example, “realPlug” is a fully functional and accessible 
MPlug.

Custom nodes with store-able internal attributes that are arrays

Custom nodes with store-able internal attributes that are arrays may 
display incorrect array indices when they are read into Maya from a 
scene file containing the node. This will be apparent in the 
MPxNode::setInternalValue() method if the number of array elements 
is compared to the plug's logical index and they are found to be equal 
in value. It is important to note that this will occur only with internal 
attributes. 

Type of MObject that Maya passes

The type of MObject that Maya passes to the following methods will 
always be MFn::kInvalid.

virtual MPxGeometryIterator * iterator (MObjectArray & 
componentList, MObject & component, bool useComponents)
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virtual MPxGeometryIterator * iterator (MObjectArray & 
componentList, MObject & component, bool useComponents, bool 
world) const

These routines are used in classes derived from MPxGeometryData. 
There is currently no workaround for this problem. 

No hooks for creating light shader nodes

There are currently no hooks from within the API for creating light 
shader nodes with properties similar to Maya's area light node. 

Creating a blendShape

If a blendShape is created from within the API using 
MFnBlendShapeDeformer::create(), the method 
MFnBlendShapeDeformer::addBaseObject() will fail if used with the 
MObject of a curve that was newly created using 
MFnNurbsCurve::create(). 

Workaround

A simple workaround is to locate the MDagPath of the newly created 
NURBS curve and obtain the MObject from that class. This object can 
be used successfully with addBaseObject().

Tools performing “add pick”

Tools made with MPxSelectionContext perform an “add pick” by 
default as opposed to the built in Maya selection tools which perform 
a “replace pick” by default. An “add pick” adds a selection to the 
active selection list while a “replace pick” replaces the current 
selection list with the selected object or objects. 

Workaround

Use MGlobal::displayInfo() to instruct the user to left click the mouse 
in an empty part of the scene in order to begin a new selection. 

Method setCursor()

When the method setCursor() is called with an instance of an 
MPxSelectionContext class the method will fail. The same method 
called with an instance of MPxContext will function as documented. 

Method MDrawRequestQueue::isEmpty() 

Using the method MDrawRequestQueue::isEmpty() on an instance of 
MDrawRequestQueue to which no MDrawRequests have been added 
will cause Maya to crash. 
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Workaround

The method operates as documented if called on a queue to which one 
or more MDrawRequests have been added. Incorporate state checking 
code to assure that an MDrawRequest has been appended before 
make a call to isEmpty(). 

Assigning a texture shader as an input to a built-in Maya 
material shader

When a user assigns a texture shader as an input to a built-in Maya 
material shader (e.g. lambert) a connection is automatically made 
between the texture node's message attribute and the downstream 
materialInfo node's texture[0] attribute. This is necessary for accurate 
hardware rendering. This does not happen automatically with custom 
material shaders and procedures will have to be implemented to make 
the connection. Unfortunately when the scene is saved and re-opened 
the texture will no longer be connected to the materialInfo node's 
texture[0] attribute. Instead the material shader's message attribute 
will have this connection. 

Workaround

Procedures will have to be implemented to break this connection and 
reconnect the texture node's message attribute with the texture[0] 
attribute. Possible solutions may include: the registering of a callback 
in the plug-in's initialize method to check for this connection and alter 
it if necessary, or the modification of the AE template script to make 
such connections when necessary. 

Monitoring the desired hardware resolution of a Texture2d 
node

To monitor the desired hardware resolution of a Texture2d node the 
renderer queries its resolution attribute. This attribute is added 
dynamically to a texture when the user sets the Hardware Texturing 
>Texture Quality of a built in material shader node (e.g. lambert.). 
This is not the case with custom material shader plug-ins. 

Workaround

A procedure must be implemented that will dynamically add the 
resolution attribute (type kLong) to an input texture. The resolution 
attribute can have the values: 32, 64, 128, or 256.

Method MFnAmbientLight::create(MObject Parent)

The method MFnAmbientLight::create(MObject Parent) should return 
an MObject representing the light shape and set Parent as the 
lightShape's parent node. This does not happen; instead, a new 
transform is created and the ambient lightShape is made a child of 
that node. 
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Workaround

Locate the current parent transform of the returned MObject; delete it; 
create an instance of MFnDagNode that is set to Parent, and use 
MFnDagNode::addChild(lightObject) to create the correct DAG 
hierarchy.

MPxContext::doHold() method

The MPxContext::doHold() method is called on a context tool even if 
the ALT key is pressed. Ordinarily the use of the ALT key should 
override the context tool and allow exclusive use of the tumble 
mechanism. Instead, both happen simultaneously. 

Shader plug-ins and using float2 compound attributes

Shader plug-ins that make use of float2 compound attributes may 
occasionally receive incorrect data from the data block. 

Workaround

It is best to extract the data as a compound attribute, and retrieve the 
contents individually. In other words, the first example is preferred 
over the second equivalent example. 

float2& uv = block.inputValue( aUVCoord ).asFloat2(); 
float u = uv[0]; 
float v = uv[1]; 

vs. 

float& u = block.inputValue( aUCoord ).asFloat(); 
float& v = block.inputValue( aVCoord ).asFloat(); 

Coding it the second way may result in the u and v values being the 
same in certain cases.

Calling MFnMesh::deleteFace()

A call to MFnMesh::deleteFace() will insert a deleteComponent node 
as construction history upstream from the affected mesh, however a 
call to MFnMesh::addPolygon() does not insert a corresponding 
construction history node. 

Workaround

MFnMesh::addPolygon() should only be used from within the 
compute method of a node that is placed upstream from the affected 
mesh object. Within the compute method the MFnMesh instance will 
act upon the kMeshData that is passed through as input and output 
data.

Querying the active view port within the API

There is no way within the API to query the active view port to find 
out if textures are currently displayed, nor is it possible to set this 
option. 
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MPxCommand and complex data types

When writing an MPxCommand that is intended to receive arguments 
from the MEL command line, please be aware that there is no way to 
hand a command plug-in a complex data type by pointer value. 

Workaround

The class MArgList contains several methods that permit the passing 
of complex data types from the MEL command line to a plug-in 
command. These are:

MStatus get( unsigned& indexReadAndUpdate, MVector&, unsigned 
numElements=3 ) const
MStatusget( unsigned& indexReadAndUpdate, MPoint&, unsigned 
numElements=3 ) const
MStatusget( unsigned& indexReadAndUpdate, MMatrix&) const
MStatusget( unsigned& indexReadAndUpdate, MIntArray& ) const
MStatusget( unsigned& indexReadAndUpdate, MDoubleArray& ) 
const
MStatus get( unsigned& indexReadAndUpdate, MStringArray& ) 
const

MFnPluginData::create() will fail to maintain a reference to an 
MObject

MFnPluginData::create() will fail to maintain a reference to an 
MObject if the assignment is not done at the time of creation. For 
example this will fail: 

fnPluginDat.create(id, &stat);
MObject obj = fnPluginDat.object();

Workaround

Always assign the MObject at the time of creation so that a reference 
will be maintained internally. For example:

MObject obj  = fnPluginDat.create(id, &stat);

MFnFreePointTriadManipulator::setSnapMode(false)

If MFnFreePointTriadManipulator::setSnapMode(false) is set to false, 
it will remain in snapMode if a single axis handle is manipulated. If 
the central handle is used the manipulator will move freely. 

Global selection list does not preserve selection order of mesh 
object components

The global selection list does not preserve selection order of mesh 
object components. For example, a tool designed to operate selected 
mesh vertices should not depend on the selection order. 

MItDependencyGraph only traverses connections that affect 
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the specified starting plug or node

MItDependencyGraph only traverses connections that affect the 
specified starting plug or node. Therefore, it may not traverse some 
connected nodes, such as connections to message attributes or 
dynamic attributes. Also, connections to a transform node's translate, 
rotate, scale attributes will not be found if traversing upstream 
through the worldMatrix output. Additionally, since 
AnimUtil::isAnimated() relies on MItDependencyGraph for its 
functionality, it will not find animCurves connected to the translate, 
rotate or scale if getting there requires traversing the transform node's 
worldMatrix attribute. 

Workaround

When using MItDependencyGraph, when a transform node or 
message plug is reached, prune the current iteration and start another 
MItDependencyGraph. When using MAnimUtil::isAnimated(), when 
a transform node or message plug is reached, call 
MAnimUtil::isAnimated() again.

Using MFileIO::open() and MFileIO::newFile() 

When using MFileIO::open() and MFileIO::newFile() on file open/file 
new, light linker nodes are not deleted, and these can accrue after 
repeated uses of these methods. 

Workaround

To avoid this problem use the equivalent MEL file open and close 
commands.

MPXSurfaceShape related problems

The following lists MPXSurfaceShape related problems for Maya 6.5.

apiMeshShape example does not support texturing

The apiMeshShape example does not support texturing. The addition 
of a texture to a material shader associated with this shape will cause 
a fatal exception and Maya will exit without saving the file. 

User defined shapes created with MPxSurfaceShape

User defined shapes created with MPxSurfaceShape cannot support 
per-components texturing or shading. 
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Troubleshooting the Help server

The Help Server should start automatically after installation of Maya, and 
is available whether or not you are using Maya. However, if you get a File 
Not Found error or Can't Find the Server error when trying to view the 
Maya help, please read this document for troubleshooting tips. 

Was the help installed properly?

Please check in the Maya documentation directory to see if the Maya Help 
was installed. If there is no content in the following folder, make sure that 
your installation process happened correctly: you may need to do a 
custom installation of just the Maya Help. See the printed Installation and 
Licensing guide for details.

• Windows: <Maya install directory>/docs/ ; by default, this is 
C:\Program Files\Alias\Maya6.5\docs\

• Mac OS X: <Maya install directory>/docs/ ; by default, this is 
/Applications/Alias/maya6.5/docs/

• Linux and IRIX: /usr/alias/maya6.5/docs 

Starting the Help Server: Windows

If the Maya Help was installed (that is, there is content in the docs 
directory of your Maya installation, as you determined in the previous 
step), but the Help Server is not started, do one of the following:

• Go to the Program Group for Maya (Start > Programs > Alias > Maya 
6.5) and choose Start Maya Doc Server. 

• Go to the Services Control Panel on your computer (Start > Settings > 
Control Panel > Administrative Tools > Services), and start the Alias 
Documentation Server, if necessary. 

• At the Command Prompt, navigate to the Maya directory (usually, 
this is C:\Program Files\Alias\Maya 6.5\) and then to the docs 
folder. Type startService.bat. 

Please note that you may need to be a PowerUser/Admin Privileged 
account on your Windows machine in order to start the Alias 
documentation server service. 
Maya 6.5 Release Notes

163



22 | Documentation
Release notes > Troubleshooting the Help server
Starting the Help Server: Mac OS X, Linux, IRIX

If the Maya Help was installed (that is, there is content in the docs 
directory of your Maya installation, as you determined in the previous 
step), but the Help Server is not started, do the following:

1 Open a shell or Terminal window and cd to the location where the 
Help Server is installed. 

• On Mac OS X, this is /Applications/Alias/maya6.5/docs

• On Linux and IRIX, this is /usr/alias/maya6.5/docs

2 Start the doc server by typing: ./startdocserver.sh 

What if I can't start the help server service on 
Windows unless I'm an Administrator?

This is a known issue with Windows. Refer to the following Microsoft 
knowledge base articles for information on how to fix this.

support.microsoft.com/?kbid=256299

support.microsoft.com/default.aspx?scid=kb;EN-

US;256345

What if my browser complains that "localhost" is not 
found? Or searches the Internet for "localhost"? What 
if the server seems to be running but I can't load any 
pages from it?

This can happen if your computer is behind a proxy server.

Make sure the proxy configuration for your browser knows that you 
shouldn't be going through the proxy to access “localhost”.

• On Mac OS X, open the System Preferences and click Network, click 
the Proxy tab and enter localhost in the Bypass proxy settings box. 

• On Windows, you may need to configure one of the following: 

• In Netscape, choose Edit > Preferences and click Advanced and 
then Proxies. If you click View next to Manual Proxy 
Configuration, you can add localhost to the list of Exceptions. 

• In Internet Explorer, choose Tools > Internet Options, click 
Connections and then LAN Settings. If you click Advanced, you 
can add localhost to the list of Exceptions. 

You can also try using your computer's DNS name or IP address instead 
of localhost. In Maya, choose Window > Settings/Preferences > 
Preferences and click Help. Set Help Location to Remote and enter http:/
/<your computer's name or IP address>:4448/Maya6.5/en_US/.
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(IRIX) What if I can’t get the Maya Docs Server to 
work with my version of Java?

If you have problems getting the Maya Docs Server to work with your 
version of Java (IRIX), then you can modify startDocServer.sh and 
enter the full path to your Java executable. See detailed instructions 
below. 

To avoid updating the version of Java:

1 Open swmgr with the Maya 6.5 IRIX CD-ROM as the dist source.

2 Click the Custom Installation button, then select and deselect the 
software components you require. For example, deselect the Java 
component if you already have a version of Java on your system that 
you want to use.

After installing the Maya Documentation Server and Maya 6.5 (English) 
Documentation, you need to configure it to use your copy of Java.

To configure Maya to use your copy of Java:

1 In a text editor, open the file:

/usr/aw/maya6.5/docs/startDocServer.sh

2 Find the PLATFORM case structure, and under "IRIX*)", remove the 
if-then-else structure, and replace it with a definition with the path to 
your Java installation, for example:

JAVACMD=<path-to-your-java>

Alternately, you can add another "elif" branch to the existing if-then-
else structure containing your definition, rather than replacing all of 
the structure.

* If you have trouble with this, make sure you have the correct, full 
path to your installed Java executable.

To help in debugging problems:

Run the script as:

sh -x /usr/aw/maya6.5/docs/startDocServer.sh

where -x invokes the shell program in verbose mode.

Also see the files: 

• /tmp/MayaDocServer.err

• /tmp/MayaDocServer.log

• /tmp/MayaDocServer.pid

 The latter two files may not exist if the server did not start.
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What if I still can't view help from the help server? 
What if the Web server won't start?

There are a few other conditions that may prevent the help server from 
starting:

Port issues

The Help Server may not start if another network service on your machine 
has already claimed port 4448. You can make the Maya help server use a 
different port number by editing docs/port.txt under the main Maya 
folder. 

The Help Server may not start if another copy of the Help Server is still 
running on the same port. Try opening a page from the server in a 
browser (for example http://localhost:4448/Maya6.5/en_US/) to see 
if this is the case. 

Certain Internet security and anti-virus software (such as ZoneAlarm and 
Norton Internet Security) may block software from using http ports on 
your system. The software may pop up a query window, asking you to 
allow the Help Server to use port 4448, or it may block the use of the help 
server without giving you a status message. You can configure your 
security software to allow access through port 4448. See your security 
software documentation for details. 

Windows Misconfiguration

On Windows, the Maya help server runs as a network service, and Maya 
uses the net start and net stop commands to control it. It is possible for 
Windows to be misconfigured to the point where these commands are not 
available on the command line. To test this, open a command window and 
type net start aliasdocserver. If the computer responds that the net 
command is not a command, you need to fix your system paths to include 
the directory with the net command. 

No Mac TCP/IP settings

If your Macintosh is not yet set up to use a TCP/IP network, the Help 
Server will not run. You can get around this limitation by manually 
configuring a loopback network with the following values:

IP Address: 192.0.0.100 

Subnet Mask: 255.255.255.0 

Router: 192.0.0.1 
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Old help servers

On Mac OS X, IRIX, or Linux, you may get a condition, especially after 
uninstalling and reinstalling, where an old help server is still running and 
unable to serve content. Find the server process in the process list (grep 
for java and/or lucene) and kill it, then restart Maya. 

How do I shut down the help server?

On Mac OS X, Linux, or IRIX, do the following:

1 Open a shell or terminal window and cd to the location where the 
Help Server is installed. 

• On Mac OS X, this is /Applications/Alias/maya6.5/docs

• On Linux and IRIX, this is /usr/alias/maya6.5/docs

2 Stop the doc server by typing: ./stopdocserver.sh

On Windows, do one of the following:

• Go to the Control Panel, double-click Administrative Tools, then open 
Services. Right-click the Alias Documentation Server line and choose 
Stop. 

• Open a command window and type net stop aliasdocserver.

• At the Command Prompt, navigate to the Maya directory (usually, 
this is C:\Program Files\Alias\Maya 6.5\) and then to the \docs 
folder. Type stopService.bat. 

To view the Maya Help again, you must restart the help server. See 
”Starting the Help Server: Windows” on page 163 or ”Starting the Help 
Server: Mac OS X, Linux, IRIX” on page 164.

Shutting down the help server when you quit Maya

By default, the help server stays active whether you are working in Maya 
or not. You can choose to shut down the service when you quit Maya by 
setting the shutDownDocServer option variable. If the value is set to 1, the 
help server stops when Maya quits. If the value is set to 0, the help server 
runs whether or not Maya is running.

Do one of the following:

• Edit the value for shutDownDocServer variable in your userPrefs.mel, 
then start Maya.

• Execute one of the following MEL commands in Maya:

optionVar -iv "shutDownDocServer" 1;

optionVar -iv "shutDownDocServer" 0;
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Viewing the online help without using the 
help server

Please note before you begin: if you read the help outside the Maya help 
server, search is not available. For this reason you may want to consider 
using a centralized Maya help server instead of moving the help onto a 
different Web server.

The Maya help server reads the online help from inside Zip files. In order 
to read the help files directly from the filesystem or from a Web server 
other than the Maya help server, you need to unzip the help content.

1 Stop the Help server. See ”How do I shut down the help server?” on 
page 167.

2 Under the main Maya folder, go to docs/Documents/Maya6.5/en_US. 
This folder contains the online help content.

3 Unzip all the zip files into directories with the same names. For 
example, put the contents of Painting.zip into a directory called 
Painting/

Make sure you don't accidentally create a structure like Painting/
Painting/.

4 Copy the contents of the misc/no_server directory of your help 
system to the root of your help system (that is, docs/Documents/
Maya6.5/en_US).

5 Rename index.html to index.old.html.

6 Rename index_no_server.html to index.html.

7 Once you have unzipped the files and set up the no_server index files, 
you can move your help system to a Web server, or leave the files 
where they are if you just want to be able to read them directly from 
the file system without using a server.

8 Open Maya and choose Window > Settings/Preferences > Preferences. 
Click Misc. Under Help Location click Remote and enter the URL of 
the help’s new location, either the URL of the directory on the Web 
server or a file: URL pointing to the docs directory. For example:

file://C|/Program Files/Alias/Maya6.5/docs/Documents/

Maya6.5/en_US/ 

file://usr/aw/maya/docs/Documents/Maya6.5/en_US/

http://helpserver:4448/Maya6.5/en_US/
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Netscape errors to the console

Netscape errors to the console when using Maya help are usually a 
result of an improperly installed version of Netscape or multiple 
installed versions. Common error messages are:

usage: xprop [-options ...] [[format [dformat]] 

atom]

or

Can’t find Lock file!

Workaround

Make sure the shell command which netscape returns the intended 
version. If not, modify your PATH environment variable so the 
intended version is correctly located. 

Essential skills movies require QuickTime 6.5

To view captions in English properly in the Essential skills movies, 
QuickTime 6.5 must be installed. Previous versions of QuickTime may 
display the movies correctly, but may not display the captions 
properly. Please upgrade to QuickTime 6.5X if you experience any 
problems viewing the movies.

Essential skills movies Japanese captions

Some Japanese captions may not display properly on Windows 
operating systems with QuickTime-J 6.5X. This was a known issue 
with Apple QuickTime on Windows when Maya 6.5 was shipped.
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